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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2001-2013 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Intel® and Itanium® are trademarks of Intel Corporation in the U.S. and other countries.

Microsoft®, Windows®‚ Windows® XP are U.S. registered trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

Support

Visit the HP Software Support Online website at:

http://www.hp.com/go/hpsoftwaresupport 

This website provides contact information and details about the products, services, and support that HP 
Software offers. 

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the support website to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training
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Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

Support Matrices

For complete support and compatibility information, see the support matrix for the relevant product release. 
All support matrices and product manuals are available here on the HP Software Support Online website:

http://h20230.www2.hp.com/sc/support_matrices.jsp

You can also download the HP Server Automation Support and Compatibility Matrix for this release from the 
HP Software Support Online Product Manuals website:

http://h20230.www2.hp.com/selfsolve/manuals

Documentation Updates

To check for recent updates or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, click 
the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. See Documentation Change Notes for a list of any revisions.

Product Editions

There are two editions of HP Server Automation:

• HP Server Automation (SA) is the Enterprise Edition of Server Automation. For information about Server 
Automation, see the SA Release Notes and the SA User Guide: Server Automation.

• HP Server Automation Virtual Appliance (SAVA) is the Standard Edition of Server Automation. For more 
information about what SAVA includes, see the SAVA Release Notes and the SAVA at a Glance Guide. 
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1 Why Use SA for Virtualization Management?
Virtualization management in HP Server Automation provides: 

• Visibility into your datacenter and all your physical and virtual machines (VMs). 

• Compliance with all your regulatory and enterprise policies.

• Control over your entire virtual environment so you can keep VM sprawl in check and 
detect and resolve problems quickly. 

Visibility

SA provides full visibility into your hybrid, heterogeneous, distributed datacenters: 

• Genealogy of VMs - SA records how each VM was created and displays it in the 
Virtualization view of the SA Client. You can also perform searches on how VMs were 
created.

• Search for VMs by Virtual Characteristics - Advanced search allows you to locate 
VMs, VM templates, hypervisors, clusters, resource pools, and datacenters by cluster 
properties, resource pool properties, number of processors, datastore, hypervisor, memory, 
creation method, power state, and many other criteria.

• One Tool, One Unified View - SA Client’s integrated view lets you see and manage your 
physical and virtual assets across virtualization technologies and in all your datacenters.

• Support for Major Virtualization Vendors - You can view and manage virtual 
machines and virtual environments from VMware, Microsoft, Oracle, and 
Hewlett-Packard. SA allows you to synchronize with these vendors’ tools to ensure you 
have access to all changes and can update your data accurately. 

• Across Physical and Virtual Machines - You can use the same processes to view, 
provision, install software and patches, configure, audit, and remediate your physical 
servers and VMs.

• See All Virtual Assets - SA provides comprehensive details about all your virtual assets, 
such as datacenters, resource pools, clusters, hypervisors, virtual machines, folders, 
datastores, and network elements.

• See Outside and Inside Servers - SA gives you a view of both the outside of your 
servers – location, relationships with other servers – and inside your servers – hardware, 
software, and configurations:

— See Outside Your VMs - SA provides a single view of your entire datacenter, across 
physical and virtual boundaries, across virtualization vendors, across networks, and 
across geographies. 

— See Inside Your Servers - SA lets you manage and provision the operating system, 
install and configure software, install patches, audit servers to detect compliance 
drift, and remediate servers to bring them back into compliance. 
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— Extensible – You can store any custom information about your VMs in custom 
attributes. Then you can perform operations based on custom attribute values.

• All Major Operating Systems - You can provision, configure, and manage servers 
running on operating systems such as Windows, Red Hat Linux, Oracle Linux, SuSE 
Linux, VMware ESX, Oracle Solaris/SunOS, HP-UX, AIX, and CentOS. 

• Storage - SA gives you end-to-end visibility to your datastore inventory, physical and 
virtual disks, and DVDs.

• Networks - You can view detailed network information about physical servers and VMs, 
their network connections, and interfaces.

Compliance

With SA, you can keep your physical servers and VMs in compliance with your enterprise 
business, industry, and government IT requirements:

• Create VM Templates from Baseline Servers - VM templates contain everything 
needed to create standard, fully compliant, and fully manageable VMs – operating 
system, patches and patch policies, software and software policies, and audit policies.

• Guest Customization - After you create VMs, you can modify them to be network ready.

• Audit Reports Detect Compliance Drift – Regular audits identify servers that have 
been modified and are no longer in compliance.

• Remediate Servers Back Into Compliance – You can bring all your noncompliant 
servers back into compliance by installing required software and patches and 
reconfiguring your systems and software.

Control

SA provides users with the ability to create and manage VMs:

• Full End-to-End VM Life Cycle - You may create compliant, provisioned VMs from 
templates; monitor, modify, audit, and remediate them to keep them in compliance; and 
delete them when you no longer need them.

• Discovery - SA discovers the environment managed by a Virtualization Service (VS) to 
provide an inventory of VMs and associated networking and storage assets.

• Create and Provision - You may create, clone, and deploy VMs from templates. All VMs 
are provisioned with the operating system, application software, and configurations your 
users need and your IT standards require. 

• Place VMs - SA provides you with full visibility and placement control.

• Update Templates - Keep your templates up to date with the latest patches, software, 
and configurations. 

• Detect Changes and Resolve Problems - Detect changes and solve problems across all 
physical servers and VMs. 

• Power Controls - With SA, you have full power controls over your VMs, including power 
on, power off, suspend, pause, reset, restart guest, and shut down guest.
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• Performance - Allows you to detect overloaded and underutilized resources and move 
VMs from one host to another to balance resource usage. 

• Quick Access - SA provides quick access to your servers with SA’s Global Shell and 
remote login.
Why Use SA for Virtualization Management? 11
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2 The SA Client Virtualization Tab
The SA Client allows you to manage your virtualization services (VSs) and create and manage 
VM templates and VMs. This section introduces you to the SA Client Virtualization tab and 
the Devices tab used to manage your VMs.

Virtualization Tab

To start managing your VSs, select the Virtualization tab in the SA Client, as shown in 
Figure 1. This displays your virtualization inventory, including VMware vCenter servers and 
Microsoft System Center Virtual Machine Manager (SCVMM) servers.

To bring your VSs under SA management, select the Actions menu or right-click on VMware 
vCenter or Microsoft SCVMM, and select Add Virtualization Service. For details, see Add 
Virtualization Service on page 38. 

Figure 1 SA Client Virtualization Tab
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After adding the VS to SA, the SA Client displays the virtualization inventory under the VSs 
in the navigation pane. Locate the desired host, folder, or other element in the virtualization 
hierarchy. 

Select the Hosts & Clusters view or the VMs & Templates view to focus your view on just 
those elements of your VMware vCenter Server.

Figure 2 Hosts & Clusters View, VMs & Templates View

Select an item in the virtualization inventory, then select one of the following tabs:

• Immediate Descendants - Shows only items immediately under the selected item. Does 
not show the contents of any folders below the selected item.

• All Virtual Machines - Shows all VMs under the selected item, no matter how far down 
in the folder hierarchy.

• All Hosts - Shows all hypervisors under the selected item, no matter how far down in the 
folder hierarchy.
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Figure 3 Tabs Showing Different Views

Right-click or use the Actions menu to perform a variety of operations on any item in the 
Virtualization inventory. For details, see Virtual Machine and VM Template Tasks on page 43.

Figure 4 Use the Actions Menu to Manage VSs, VMs, and VM Templates
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Icons for Virtualization Items

Table 1 shows the various icons for your virtualization inventory. 

Table 1 Icons for Virtualization Items

Icon Description

Hypervisor running the SA agent and 
communicating with the SA core 

Agentless hypervisor 

VM template, including the SA agent 

VM template, not including the SA agent 

VM running the SA agent and 
communicating with the SA core 

VM running the SA agent, not 
communicating with the SA core 

VM not running the SA agent, not 
communicating with the SA core

VMware Virtualization Service 

VMware datacenter 

VMware folder containing VMs and VM 
templates 

VMware folder containing hosts and 
clusters 

VMware cluster 

Microsoft host group 

Microsoft Virtualization Service 

Microsoft cluster 

Microsoft All VM Templates folder 
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Devices Tab

Select the Devices tab in the SA Client to manage your VMs just as you would do for physical 
servers.

Figure 5 The Devices Tab Shows Virtual and Physical Servers

With SA you can provision, patch, install software, configure, audit, and generate reports for 
all your virtual and physical servers. For details, see the following guides:

• SA User Guide: OS Provisioning

• SA User Guide: Server Patching

• SA User Guide: Software Management

• SA User Guide: Application Configuration

• SA User Guide: Audit and Compliance

• SA Reports Guide

• SA User Guide: Server Automation
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Managing Oracle Solaris Zones

You can manage Oracle Solaris Zones with SA. To do so, perform the following steps:

1 In the SA Client, select the Devices tab.

2 Select Servers > Oracle Solaris Zones. This displays your Oracle Solaris Zones.

For more information, see Managing Oracle Solaris Zones on page 97.

Managing HP-UX Virtual Servers

For information on managing HP-UX virtual servers, see Managing HP-UX Virtual Servers 
on page 67
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3 Setting Up a Virtualization Environment
This chapter describes how to set up your virtualization environment with Virtualization 
Services such as VMware vCenter Server and Microsoft SCVMM.

VS Scenario

This section describes a simple VS configuration that divides up the virtualization resources 
into two containers – two datacenters – and delegates responsibility to two sets of 
administrators. You can expand this scenario to additional roles and additional containers, 
such as hypervisors and resource pools, using the same techniques.

This configuration (Figure 6) shows two datacenters, one for each department:

• Finance Department Datacenter - The Finance department needs primarily Windows 
servers, with a few Linux servers.

• Developer Department Datacenter - The Developers need primarily Linux servers, 
with some Windows servers.

Figure 6 Virtualization Service with Two Datacenters
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VS Roles

This section describes the following roles for managing virtualization resources. Each role 
may be performed by a separate person, by more than one person, or one person may perform 
multiple roles. Each role could be expanded into multiple roles. Use these roles as a guideline 
to establish responsibilities and keep your virtual environment compliant and under control.

• VS Administrators - VS administrators have full administrative permissions in the VS 
and full visibility to the various groups, departments, or customers who are using the VS.

— Allocates the virtualization resources of the VS among various departments.

— Assigns permissions to each set of users, the VM template managers, VM deployers, 
and VM managers. 

• VM Template Managers - This role has visibility only to the part of the VS that their 
users need.

— Creates VM templates for each type of VM their customers need.

— Keeps the VM templates up to date and refreshes them periodically as needed.

— Provides the VM templates to the VM deployers.

• VM Deployers - This role has visibility only to the part of the VS that their users need 
and has limited permissions.

— Gets the VM templates from the VM Template Manager.

— Deploys VMs from VM templates for their customers. 

• VM Managers - This role has visibility only to the part of the VS that their users need 
and has limited permissions.

— Manages the VMs as they would manage any physical system - installs patches and 
software, performs audits, and so forth.

Action Permissions for Each Role

This section describes the set of action permissions needed by each role based on the VS 
Scenario on page 19. Permissions are granted to a user by adding the user to a user group. 
Table 2 shows the roles described above and the user group that grants the action permissions 
appropriate for that role.

Table 2 User Groups for Each Role

Role Appropriate User Group

VS Administrator Virtualization Administrator

VM Template Managers VM Template Managers

VM Deployers VM Template Deployers

VM Managers VM Lifecycle Managers
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Virtualization Container Permissions for Each Role

This section describes the set of VS container permissions needed by each role based on the 
VS Scenario on page 19. Permissions are granted to a user by granting “folder” permissions on 
each container or item in the virtualization hierarchy. The virtualization hierarchy consists of 
one or more of the following, depending on which VS you are using and on how you have 
organized your virtualization resources:

Table 4 shows the VS container permissions you would grant for each role described in the VS 
Scenario on page 19.

To give different VS container permissions to different sets of users, create a separate user 
group for each user group based on the standard user groups. Table 4 lists the user groups to 
create and the appropriate permissions to assign.

Table 3 Virtualization Containers and Other Items

VMware Virtualization Items Microsoft Virtualization Items

• Datacenters

• Clusters

• Hypervisors

• Resource Pools

• VMs

• VM Templates

• Folders

• Host Groups

• Clusters 

• Hypervisors

• VMs

• VM Templates

Table 4 User Groups and VS Container Permissions

New User Group to 
Create Action Permissions VS Container Permissions

VS Administrator Same as the Virtualization 
Administrators user group.

Access to entire virtualization 
inventory.

Finance VM Template 
Managers

Same as the VM Template 
Managers user group.

Access restricted to Finance 
Datacenter.

Finance VM Deployers Same as the VM Template 
Deployers user group.

Access restricted to Finance 
Datacenter.

Finance VM Managers Same as the VM Lifecycle 
Managers user group.

Access restricted to Finance 
Datacenter.

Developer VM Template 
Managers

Same as the VM Template 
Managers user group.

Access restricted to Developer 
Datacenter.

Developer VM Deployers Same as the VM Template 
Deployers user group.

Access restricted to Developer 
Datacenter.

Developer VM Managers Same as the VM Lifecycle 
Managers user group.

Access restricted to Developer 
Datacenter.
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4 Managing Permissions
This section describes how to set permissions in your virtualization environment. For more 
information on permissions, see the SA Administration Guide.

Virtualization User Groups

Permissions are granted through user groups. SA provides a set of user groups based on 
typical roles that are intended to help you set up your own user groups specific to your 
environment.

Best Practice: Make a copy of the HP-provided user groups listed in Table 5 and modify them 
to provide the permissions your staff needs. These user groups are provided as a starting 
point, and you should create your own user groups based on these user groups. For an 
example of creating user groups for a specific scenario and set of roles, see Setting Up a 
Virtualization Environment on page 19.

Table 5  Virtualization User Groups

User Group Name Description

Virtualization Administrators Access to add, edit, and remove virtualization services, 
manage life cycle of VMs and VM templates, and administer 
permissions for your virtualization inventory.

VM Lifecycle Managers Access to manage lifecycle of VMs, including create, modify, 
migrate, clone, remove VMs, VM power controls, and deploy 
VMs from VM templates.

VM Template Deployers Access to deploy VMs from VM templates, clone VMs, and 
VM power controls.

VM Template Managers Access to manage lifecycle of VMs and VM templates, 
including create, modify, migrate, clone, remove VMs, VM 
power controls, convert VMs to VM templates, deploy VMs 
from VM templates, and remove VM templates.
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Virtualization Permissions

To perform virtualization actions, you need the following four types of permissions:

• Action Permissions allow you to perform specific tasks such as cloning a VM, deploying 
a VM from a VM template, converting a VM to a VM template, and so forth. Without 
action permissions, the corresponding menu items are not even displayed in the Actions 
menu of the SA Client. For a complete list of action permissions, see the SA 
Administration Guide.

• Virtualization Container Permissions give you access to the Virtualization Services 
and the containers under the VS. These containers can be datacenters, hypervisors, host 
groups, clusters, resource pools, and folders under the Virtualization Service.

• Server Resource Permissions give you access to facilities, customers, and device 
groups where the VMs will run. For more information on server resource permissions, see 
the SA Administration Guide.

• Folder Permissions give you access to items in the SA Library needed by VMs, such as 
OS Build Plans, patches, and patch policies, software packages and software policies, 
application configurations, audit policies, and reports. For more information on folder 
permissions, see the SA Administration Guide.

Figure 7 shows some of the key permissions needed to create a VM for the customer Acme and 
provision it with an OS build plan.

Figure 7 Partial Permissions Needed to Create a VM

Depending on your particular virtualization hierarchy, some or all of the following 
permissions are required for complete authorization to create a VM:

• Action Permissions: These action permissions are required to create and provision a 
VM.

— Manage VM Lifecycle: Create VM - This is the basic action permission required to 
create a VM.

— Managed Servers and Groups - This is the basic action permission required to view 
managed servers.
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— View Virtualization Inventory - This is the basic action permission required to view 
the virtualization inventory under the Virtualization tab in the SA Client. Without 
this permission, the Virtualization tab is not displayed in the SA Client.

— Allow Execute OS Build Plans - This is the action permission required to provision a 
server using an OS build plan.

— Manage Package = Read - This action allows you to select the boot image ISO in the 
SA client when performing an OS build plan without network boot, or PXE.

• Virtualization Container Permissions: These permissions depend on how your 
virtualization hierarchy is organized.

— Inventory Folder: Write - This gives you write access to the virtualization inventory 
folder where the new VM will be stored.

— Hypervisor: Write - This gives you write access to the hypervisor where the new VM 
will run.

— Resource Pool: Write - This gives you write access to the resource pool where the new 
VM will run.

— Datacenter: Read - This gives you write access on the datastores underlying that 
datacenter. 

• Server Resource Permissions: These permissions give you access to managed servers.

— Facility: Write - This gives you write access to the facility where managed servers are 
located.

— Customer: Write - This gives you write access to the managed servers assigned to the 
customer. Every managed server is assigned to a customer, and you must grant access 
permissions to customers.

— Device Groups: Write - This gives you write access to the device groups in which your 
VMs will be included automatically. For more information on device groups and 
customers, see the SA User Guide: Server Automation.

• Folder Permissions: These permissions give you access to items in the SA Library and 
depend on where (in which folder) these items are located in the SA Library.

— OS Build Plan folder: Execute - This gives you permission to use the OS build plans in 
the folder. 

Setting Virtualization Container Permissions

This section describes how to set virtualization container permissions. For information on the 
other types of permissions (action permissions, server resource permissions, and folder 
permissions), see the SA Administration Guide.

To perform any virtualization actions, including creating, deleting, modifying, or viewing 
items in your virtualization inventory, you must have virtualization container permissions, 
such as a datacenter, host, resource pool, and host cluster, on the container of the virtual 
resources.

— All folders that reside above the targeted hypervisor and the inventory folder must 
have List permission.

— VMs and VM templates inherit permissions from their parent container. 
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– In vCenter, you must have at least Read permission on a folder to view and 
manage the VMs and VM templates on that folder. 

– In SCVMM, you must have at least Read permission on a hypervisor to view and 
manage the VMs hosted by that hypervisor. To view all templates in SCVMM, you 
need at least Read rights on the “All VM Templates” folder.

To set access permissions on virtual resources, perform the following steps.

1 In the SA Client, locate the virtual resource where you want to set permissions. For 
example, Figure 8 below shows two datacenters, a cluster within a datacenter, and three 
resource pools within the cluster on the VS:

Figure 8 VS Showing Two Datacenters, a Cluster and Three Resource Pools
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2 Select the virtual resource where you want to set permissions, then right-click and select 
Permissions. This displays the permissions window for that resource. Figure 9 shows the 
virtualization container permissions window for the cluster named jlCluster.

Figure 9 Setting Virtualization Container Permissions on a Cluster

3 Select the user or user group on which you want to set permissions. Use the Add and 
Remove buttons to add or remove user groups and users.

Best Practice: Grant permissions only to user groups, not to individual users. Granting 
permissions through user groups is recommended, because it is more manageable and 
maintainable than granting permissions to individual users. For more information on user 
groups, see the SA Administration Guide.

4 Select the check boxes to grant the desired permissions.

5 Select Apply or OK to save the permissions.

6 If the virtualization container is itself contained within other ancestor virtualization 
containers, you may be asked to grant List permissions on the ancestor containers.

If the virtualization container contains other children containers, you may be asked to 
grant the same permissions to the children containers.

If asked, select whether or not to propagate the permissions to the ancestor containers or 
the children containers.

7 Select Apply or OK to save the permissions.
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5 Virtual Machine and VM Template Life Cycle
By setting up a well-defined process of deploying, managing and deleting VMs and VM 
templates, you can control VM sprawl and VM compliance drift. This section describes and 
recommends processes for creating, managing, and deleting VMs and VM templates.

This section assumes you have added your Virtualization Service (VS) into SA and are 
managing your VS from SA, typically the SA Client. For more information, see Add 
Virtualization Service on page 38.

Figure 10 summarizes the VM template and VM life cycle:

Figure 10 Virtual Machine Life Cycle 

The following sections describe each part of the VM life cycle.

Create VM Templates

This section explains how to create VM templates. VM templates ensure your users deploy 
standard VMs that you can monitor, keep in compliance, and destroy efficiently so they do not 
waste your IT resources.

Best Practice: Create a limited number of VM templates. The fewer different templates you 
have to manage, the easier it will be to manage them and the VMs your users deploy from 
them.

Figure 11 summarizes the process of creating a VM template.
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Figure 11 Creating a VM Template

1 Determine the basic types of VMs your users will be deploying.

Each type of VM consists of the operating system, software applications, software and 
system configurations, patches to be installed, and audit rules that must be followed for 
compliance.

For example, you might have the following four basic types of VMs:

• Windows machine for administrative and managerial users.

• Windows machine for financial users.

• Linux machine for software developers and testers.

• Linux machine for production systems.

You could create two VM templates, one for the Windows servers and one for the Linux 
servers, and customize the VMs after deploying them from the templates. Or you could 
create four separate VM templates. Either method can work, but each has different 
trade-offs, benefits, and drawbacks. Table 6 lists some of the benefits and drawbacks of 
each strategy:

Table 6 Comparing Two and Four VM Templates

Benefits Drawbacks

2 VM Templates - 
One for all Windows 
servers and one for all 
Linux servers

Fewer VM templates 
to maintain.

You must customize each VM for the 
intended user (administrative user or 
financial user for Windows, developer 
or production user for Linux) after 
deploying it.

4 VM Templates - 
Two for Windows servers 
and two for Linux Servers

No customization of 
VMs required after 
deploying them.

More VM templates to maintain.
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2 For each type of VM your users will be deploying, create that VM as a “golden,” or 
baseline, VM:

a Create the VM. The simplest way to do this is to clone an existing VM that represents 
the VM or is close to the VM, or deploy a VM from a VM template that is close to the 
desired VM. Otherwise you can create a VM from scratch. For more information, see 
Create and Provision a VM - vCenter on page 45.

b Unless already done, install the operating system using an OS Build Plan. See the SA 
User Guide: OS Provisioning.

c Create a patch policy for the VM that includes all the patches required by the VM. 
Attach the patch policy to the VM. See the SA User Guide: Server Patching.

d Create a software policy for the software required for the VM. Attach the software 
policy to the VM. See the SA User Guide: Software Management.

e Create application configurations for the VM. Attach the application configurations to 
the VM. See the SA User Guide: Application Configuration.

f Create an audit policy for the VM. Attach the audit policy to the VM. See the SA User 
Guide: Audit and Compliance.

g Remediate the VM to incorporate all policies into the golden VM.

3 From each golden VM, convert the VM to a VM template. For more information, see 
Convert a VM to a VM Template - vCenter on page 64.

When you convert a VM to a VM template, the VM no longer exists. If you want to keep 
the VM, clone the VM first, then convert the VM to a VM template. Or deploy a VM from 
the VM template immediately after creating the VM template.

4 Instruct your users to deploy VMs from your VM templates. These VMs will conform to 
your standard policies and be maintained by your standard processes for managed 
servers.

Deploy VMs from VM Templates

Ensure your users use your VM templates whenever they deploy VMs so they create standard 
VMs that you can manage. For instructions on deploying VMs from VM templates, see Deploy 
a VM from a VM Template - vCenter on page 50.

Keep VMs in Compliance

To keep your VMs in compliance, perform regular compliance checks and audits to determine 
which VMs are out of compliance with the attached policies. Remediate noncompliant VMs to 
bring them back into compliance.

This is the same process you use for keeping physical servers in compliance. For more 
information, see the SA User Guide: Server Patching, the SA User Guide: Software 
Management, and the SA User Guide: Audit and Compliance.
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VM Template Life Cycle

This section explains how to update and maintain your VM templates while maintaining the 
connection between the VM template and the VMs deployed from them. It is important to 
update them methodically to keep your VMs in compliance efficiently.

Here are three ways to keep templates up to date:

• Modify the contents of the policies attached to the VM template. See Modify Attached 
Policies on page 32.

• Modify the contents of the policies attached to the VM template and create a new VM 
template. See Modify Attached Policies and Create New VM Template on page 33.

• Attach one or more new policies to the VM template and to all VMs previously deployed 
from the VM template and create a new VM template. See Attach New Policies and Create 
a New VM Template on page 34.

Best Practice: Update your VM templates at regular intervals. For example, you might 
modify the attached policies weekly and create new VM templates monthly.

Modify Attached Policies

You can update your VM templates by modifying the contents of the policies attached to the 
VM template. This is the simplest method of updating VM templates.

1 Modify the policies attached to your VMs and the VM template from which they were 
created.

2 Remediate the existing VMs previously created from the VM template. This brings them 
into compliance with the updated policies.

All VMs previously deployed from the VM template immediately become noncompliant 
and require remediation to be brought back into compliance.

3 Deploy new VMs from the updated VM template.

4 Scan and remediate the new VMs to bring them into compliance with the updated 
policies.

All new VMs deployed from the updated VM template immediately require a compliance 
scan and remediation, because the baseline VM template does not contain the new 
additions to the policies.

Figure 12 shows the VM template, the VMs created from it, and the attached policies.
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Figure 12 Modify the Policies Attached to a VM Template

Modify Attached Policies and Create New VM Template

Figure 13 shows the old VM template (VM Template A), the new VM template (VM Template 
B), and the policies attached to both VM templates and to all the VMs deployed from them.

Figure 13 Modify Policies and Create a New VM Template

After updating the policies attached to your VM templates, you can create a new VM template 
from the old VM template with the same set of policies:

1 Deploy a VM from the VM template (VM Template A in Figure 13).

2 Remediate the VM.

3 Convert the VM to a new VM template (VM Template B in Figure 13). This incorporates 
the contents of all the policies into the baseline VM template (B).

4 Remediate all VMs previously deployed from the original VM template (A) to ensure they 
are in compliance.
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After creating the new VM template (B), all VMs previously deployed from the VM 
template (A) immediately become noncompliant and require remediation to be brought 
into compliance.

5 Deploy new VMs from the new VM template (B).

All new VMs deployed from the new VM template (B) are compliant and do not need 
remediation. However, they do require a compliance scan.

Attach New Policies and Create a New VM Template

This section describes how you can add new policies and create a new VM template, and 
maintain compliance of all VMs previously created from the original VM template. Figure 14 
shows this scenario before adding new policies.

Figure 14 VM Template C, Before Adding New Policies

1 Deploy a VM from the VM template (VM Template C in Figure 14).

2 Attach new policies to the VM.

3 Remediate the VM to incorporate the new policies into the baseline VM.

4 Convert the VM to a new VM template (VM Template D in Figure 15).
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5 Search for all VMs created from the original VM template (C).

All VMs previously deployed from the original VM template (C) will not have the new 
policies attached. You can search for all those VMs that were deployed from the original 
VM template (C), attach the new policies to those VMs, then remediate them to bring 
them into compliance with the new set of policies and the new VM template (D).

6 Attach the new policies to all the VMs deployed from VM templates (C). 

7 Remediate all those VMs to bring them into compliance.

8 Instruct your users to use the new VM template (D) to create VMs. All VMs deployed from 
the new VM template are compliant and do not need remediation. However, they do 
require a compliance scan.

Figure 15 shows this scenario after all steps have been completed.

Figure 15 VM Template D, After Attaching Two New Policies
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6 Virtualization Service Tasks
This section describes the tasks you can do with Virtualization Services (VS) using the 
Virtualization tab in the SA Client, as shown in Figure 16. 

Figure 16 Adding Virtualization Services to SA Management 

Supported Tasks

You can perform the following tasks with SA. Any other tasks not listed must be performed 
with the native tools.
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Add Virtualization Service

To make a VS visible to and managed by SA, you need to add it to SA.

1 In the SA Client, locate the server on which the VS is running. Ensure that this server is 
an agent-managed server, meaning it has an SA agent installed.

The simplest way to ensure the server is a managed server running the SA agent is to 
check the icon next to the server. A blue server icon indicates it is agent-managed.

Alternatively, you can examine the server summary or the server properties in the SA 
Client. Select the Devices tab and locate the server under All Managed Servers. Select the 
server, then select the Summary View or the Properties View. Examine the agent status or 
the agent version. If this information does not appear, it is not an agent-managed server. 
For information about installing the SA agent, see the SA User Guide: Server Automation.

Any server running a VS managed by SA must be an agent-managed server. That is, it must 
have an SA agent installed on it. Do not remove the SA agent from servers running VSs 
managed by SA.

2 In the SA Client, select the Virtualization tab. This displays all your registered VSs and 
the virtualization inventory under them (see Figure 16). 

3 In the navigation pane, select either VMware vCenter or Microsoft SCVMM.

4 Right-click or select the Actions menu, and select Add Virtualization Service. This 
displays the Add Virtualization Service window (see Figure 17). 

Figure 17 Add Virtualization Service Window

5 Virtualization Service Definition: Enter the following information, then select Next. 
Or select Start Job to accept the remaining defaults and run the job.
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• Select the type of VS you want to register; for example, select either VMware vCenter 
Server or Microsoft SCVMM.

• Click the Select Server button. This displays your available agent-managed servers 
running a VS. Select the server where the VS is running, then click the Select button.

Troubleshooting Tip - If the server where the VS is running does not appear, ensure that a 
software registration has been performed on the server. The only servers that appear are 
servers where the specified VS is known to be running. For more information on running a 
software registration, see the SA User Guide: Server Automation.

• If the server has more than one IP address, select the IP address to use.

• In both vCenter and SCVMM, enter the new port number to use to communicate with 
the VS.

In vCenter only: The Add VS wizard initially provides you with 443 as the default, 
which is the standard port. If you edit this field, the following window appears:

If you enter a non-standard port number, because the HP SA gateway network 
prohibits connections to non-standard ports, you must modify the configuration of 
agent gateways to permit the necessary communication paths.

For more information on modifying agent gateway configuration, see “Network 
Requirements” in the HP SA Standard/Advanced Installation Guide.

• Specify the Windows <DOMAIN>\<username> and password to the VS. 

Whether using vCenter or SCVMM, specify a user with full permissions and 
privileges to the VS and manage VS permissions through SA. 

6 Scheduling: Enter when you want the VS to be added—immediately or in the future— 
then select Next.

7 Notifications: Optionally enter a notifier, then select Next.

8 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.
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When the job runs, it adds the VS to SA management and displays the results. Once the 
VS is under SA management, you will see the virtualization inventory of the VS in the SA 
Client.

Best Practice: If you change the IP address, port, or administrator password for a VS, the 
virtualization administrator must run Edit VS to update that VS’s IP connection information.

Best Practice: Once the VS is under SA management, it is highly recommended that you 
make all its VMs agent-managed servers to have maximum visibility, control, and compliance 
for these VMs. For information about installing the SA agent, see Install the SA Agent on a 
VM on page 54, the SA User Guide: Server Automation, and the SA Simple/Advanced 
Installation Guide.

Reload Virtualization Service Data

This section explains how to update SA information about the VS. Do this whenever 
something has changed outside of SA; for example, in the native VMware or Microsoft tools.

Best Practice: If you modify elements of your virtualization inventory outside of SA, refresh 
the VS data in SA as described below to ensure SA has complete and up-to-date information. 
Otherwise, the information in SA about your virtualization inventory may be inaccurate.

Best Practice: Schedule a recurring job that runs during non-peak hours and reloads the VS 
data in SA. This task synchronizes your data with any changes that occur outside of SA, such 
as distributed resource scheduler (DRS) migrations from VMware. The frequency you choose 
depends on how large your virtual inventory is and how much it changes outside of SA. The 
larger your virtual inventory is, the longer the reload operation may take. One common 
frequency to use is every 24 hours. 

To reload the VS data, perform the following steps:

1 In the SA Client, select the Virtualization tab. This displays all your registered VSs.

2 Select a VS.

3 Right-click or select the Actions menu and select Reload Data Now or Reload Data 
Scheduled. This displays the Reload Data window.

If you selected Reload Data Now, the job begins and displays the status window.

4 Preview: If you selected Reload Data Scheduled, select Next. Or select Start Job to accept 
the remaining defaults and run the job.

5 Scheduling: Enter when you want the VS data to be reloaded, then select Next.

You can reload VS data immediately, once in the future, or set a recurring schedule, as 
described in Best Practices, above.

6 This is the key step to the 2nd best practice above -- schedule a recurring reload data job.

7 Notifications: Optionally enter a notifier, then select Next. 

8 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it reloads all the data about the VS.
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Reload Virtualization Items Data

You can reload virtualization service data on demand for all virtualization items (e.g., VMs, 
templates, resource pools, and so on). However, you cannot perform a scheduled reload on any 
virtualization item other than the VS.

Edit Virtualization Service

In vCenter, Edit VS lets you update the IP address (when the server has multiple IP 
addresses), port number, and administrator password for the VS. 

In SCVMM, you can edit the port number and password for the VS. The IP address is the SA 
management IP used to connect to SCVMM.

Best Practice: If the IP address for a VS is changed, the virtualization administrator must 
run Edit VS to update that VS’s IP connection information.

To edit the VS, perform the following steps:

1 In the SA Client, select the Virtualization tab. This displays all your registered VSs.

2 Select a VS.

3 Right-click or select the Actions menu and select Edit Virtualization Service. This 
displays the Virtualization Service Definition window.

4 Virtualization Service Definition: Modify the IP address, or the port number used to 
communicate with the VS, or the password of the VS user, then select Next. Or you can 
select Start Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the job to run, then select Next.

6 Notifications: Optionally enter a notifier, then select Next. 

7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it modifies the VS and displays the results.
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For more information about editing the VS, refer to the SA Simple/Advanced Installation 
Guide.

Remove Virtualization Service from SA

SA does not permit you to remove a VS if there are any other jobs running against it. 

When you no longer need to manage a VS from SA Management, you can remove it using the 
following process. This process removes all the VMs and hypervisors from SA management 
that are only managed by the VS. That is, any VMs and hypervisors managed by the VS that 
are also agent-managed will still be managed by SA.

1 In the SA Client, select the Virtualization tab. This displays all your registered VSs.

2 Select a VS.

3 Right-click or select the Actions menu and select Remove Virtualization Service. This 
displays the Remove Virtualization Service window.

4 Confirmation: Confirm that the VS displayed is the one you want to remove, then select 
Next. Or you can select Start Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the VS to be removed—immediately or in the future—
then select Next.

6 Notifications: Optionally enter a notifier, then select Next. 

7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it removes the VS and displays the results.

Once the VS has been removed from SA management, the virtualization inventory of the VS 
will not be displayed in the SA Client under the Virtualization tab. All physical hypervisors 
that are agent-managed or iLO-managed, or virtual hypervisors that are agent-managed will 
still be displayed under the Devices tab.
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7 Virtual Machine and VM Template Tasks
This section describes the tasks you can do with VMs and VM Templates using the 
Virtualization tab in the SA Client, as shown in Figure 18.

You can also view and manage VMs using the Devices tab. For more information, see the SA 
User Guide: Server Automation.

Figure 18 Virtualization Tab in the SA Client 

Supported Tasks

You can perform the VM and VM template tasks described in this chapter with SA. Any other 
VM or VM template tasks not listed here must be performed with the native tools. For more 
information, see also Virtualization Service Tasks on page 37.

Modify a VM Template - vCenter and SCVMM 

This section describes how to modify certain aspects of a VM template. Table 7 shows the 
actions you can perform with an agent-managed VM template and an agentless VM template.
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To modify other aspects of the VM template, you must deploy a VM from the VM template, 
modify the VM, and convert the modified VM to a new VM template. For more information, 
see Deploy a VM from a VM Template - vCenter on page 50 and Convert a VM to a VM 
Template - vCenter on page 64.

To modify a VM template, perform the following steps:

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM template you want to modify.

Table 7 VM Template Actions

VM Template Action Agent-Managed Agentless

Open the VM template

Modify the name and description

Modify the customer with which the VM template is 
associated

Modify the Server Use setting

Add, modify, and delete custom attributes

Create a snapshot specification with the VM 
template 

Deactivate the SA agent on the VM template

Deploy a VM from the VM template

Delete the VM template

Reload data about the VM template

View event history for the VM template

Add the VM template to a device group

Attach software policies to the VM template

Attach patch policies to the VM template

Attach application configurations to the VM 
template

Create an audit with the VM template

Export patch information from the VM template

Open the VM template with HP Service Automation 
Visualizer
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3 Select the VM template and right-click or select the Actions menu. Select Open to 
display the VM template in a separate window.

4 Navigate to the desired view of the VM template by selecting one of the tabs labeled 
Information, Relationships, and Inventory.

5 Use the navigation pane on the left to locate the elements of the VM template you want to 
change, and make your changes.

6 Select the File > Revert menu to discard your changes.

7 Select the File > Save menu to save your changes.

Create and Provision a VM - vCenter 

This section describes how to create a VM from scratch under a VMware vCenter Server. You 
can also deploy a VM from a VM template or clone a VM from another VM. See Deploy a VM 
from a VM Template - vCenter on page 50 and Clone a VM - vCenter on page 53 for more 
information

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the desired location where you want to place the new VM. VMs must be 
created under a datacenter. VMs can also be placed under clusters, hypervisors, or 
resource pools or in folders under these virtualization containers.

3 Select the desired location and right-click or select the Actions menu. Select Create 
Virtual Machine to display the Virtual Machine Definition window (see Figure 19). 

Figure 19 Virtual Machine Definition Window

4 Virtual Machine Definition: Enter the following information, then select Next.

• The VM name.
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• A VM description.

• A customer to assign the VM to. The default is “Not Assigned”.

• Verify or change the location in the virtualization inventory where you want to place 
the new VM.

5 Host: Navigate to and select the server that you want to host the VM. Verify that the host 
is compatible, then select Next.

6 Resource Pool: If the host or cluster has resource pools defined, navigate to and select 
the resource pool where you want to place the new VM. Select Next.

7 Compute Properties: Enter the following information, then select Next.

• Set the amount of memory for the VM.

• Set the number of virtual processors for the VM.

• Select the guest operating system that you will install on the VM.

8 Storage Location: Select the datastore with sufficient free space in which to store the 
VM configuration file, then select Next.

9 Storage Configuration: You need at least one virtual hard disk for storage. Select the 

 button to add a virtual hard disk, CD/DVD drive, or floppy drive to the VM. The 
maximum number of IDE devices you can add is 4. Specify the storage details, then select 
Next.

10 Network Configuration: Select the  button to add a network interface card (NIC). 
Specify the details for each NIC, then select Next. For each disk drive added, configure the 
following:

— Network name

— Adapter type 

— MAC address: Automatic (default) or manual

— Device Status: Connect at Power on (default)

Best Practice: It is recommended that you create the VM with a single network adapter to 
ensure that the job completes. However, if you must create a VM with multiple adapters, 
ensure that the NIC on the provisioning network is specified first. 

11 Advanced Options: Set the power on boot delay time, if desired, then select Next.

12 OS Installation: Specify the following to provision an OS on the VM, then select Next.

• OS Build Plan - Select the OS build plan you want to install. For more information 
on OS build plans, see the SA User Guide: OS Provisioning. To run an OS build plan, 
you must have adequate action permissions and adequate resource permissions on the 
OS build plan. For information on permissions, see the SA Administration Guide. 

SA no longer integrates Create VM with OS sequences. Contact your OS Provisioning 
administrator to create a custom OS Build Plan for your needs.

• Provisioning Method - Select the provisioning method to use:

— Network boot (PXE) - When using a PXE environment, keep the default 
settings. 

— CD/DVD boot - Uncheck Network Boot (PXE) to install the OS from physical 
media on an attached CD/DVD drive.
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IP Configuration - Select DHCP to configure your network using your 
DHCP-enabled environment, or choose Static to configure your network settings 
manually.

Static IP input varies, depending on your boot image. Linux images require that 
you enter a host name.

Figure 20 provides an example of OS Installation settings used in creating and 
provisioning a VM from a CD using a static IP address.

Figure 20 OS Installation Settings: Using a Static IP Address

• Boot Image - Select the boot image corresponding to the OS you are installing.

• Provisioning Network - Select the NIC to be used for provisioning.

• Custom Attributes - Optionally specify custom attributes. For more information on 
custom attributes, see the SA User Guide: Server Automation.

13 Preview: Verify all your VM settings. Use the Back button or select any step to make 
changes, then select Next.

14 Scheduling: Select when you want the job to run, then select Next.

15 Notifications: Optionally enter a notifier, then select Next. 

16 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it creates the VM and displays the results. Once the VM is created, 
you will see it in the virtualization inventory of the VS in the SA Client and in the Devices 
All Managed Servers view. 
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Best Practice: It is highly recommended that you make all VMs agent-managed servers to 
have maximum visibility, control, and compliance for these VMs. The easiest way is to install 
the OS using an OS Build Plan, which automatically installs the SA agent. For more 
information about installing the SA agent, see Install the SA Agent on a VM on page 54 and 
the SA User Guide: Server Automation. For more information about OS Build Plans, see the 
SA User Guide: OS Provisioning.

Create and Provision a VM - SCVMM

This section describes how to create a VM from scratch on a Microsoft SCVMM Server. You 
can also deploy a VM from a VM template. See Deploy a VM from a VM Template - SCVMM 
on page 52.

If you install any version of Linux on a VM with multiple CPUs, you must exclude the Linux 
RPM irqbalance from your installation media, or the VM’s networking will not work. This 
only applies to VMs configured with more than one CPU and running any Linux OS. 

To create a VM, perform the following steps:

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the location where you want to place the new VM.

3 Select the desired location and right-click or select the Actions menu. Select Create VM 
to display the Virtual Machine Definition window.

4 Virtual Machine Definition: Enter the following information, then select Next.

• The VM name.

• A VM description.

• A customer to assign the VM to. The default is “Not Assigned”.

• Amount of memory for the VM.

• Number of virtual processors for the VM.

• Desired guest operating system for the VM.

To create a Linux VM on SCVMM, you must select “Other Linux (64-bit)” or “Other Linux 
(32-bit).”

5 Storage Configuration: You need at least one virtual hard disk for storage. Select the 

 button to add a virtual hard disk or CD/DVD drive to the VM. The maximum number 
of IDE devices you can add is 3. Specify the storage details, then select Next.

6 Host: Select the hypervisor that you want to host the VM. Verify the host ratings, then 
select Next.

7 Storage Location: Select from the default paths configured on the hypervisor or enter a 
valid path that exists on the host. 

8 Network Configuration: Select the  button to add a NIC. At least one NIC is 
required for network connectivity. Specify the details for each NIC, then select Next.
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Best Practice: It is recommended that you create the VM with a single network adapter to 
ensure that the job completes. However, if you must create a VM with multiple adapters, 
ensure that the NIC on the provisioning network is specified first. 

9 Advanced Options: Select the action you want to perform on the VM when the 
hypervisor stops and starts, select the boot order, and then select Next.

10 OS Installation: Specify the following to provision an OS on the VM, then select Next.

• OS Build Plan - Select the OS build plan you want to install. For more information 
on OS build plans, see the SA User Guide: OS Provisioning. To run an OS build plan, 
you must have adequate action permissions and adequate resource permissions on the 
OS build plan. For information on permissions, see the SA Administration Guide. 

SA no longer integrates Create VM with OS sequences. Contact your OS Provisioning 
administrator to create a custom OS Build Plan for your needs.

• Provisioning Method - Select the provisioning method to use:

— Network boot (PXE) - When using a PXE environment, keep the default 
settings. 

— CD/DVD boot - Uncheck Network Boot (PXE) to install the OS from physical 
media on an attached CD/DVD drive.

IP Configuration - Select DHCP to configure your network using your 
DHCP-enabled environment, or choose Static to configure your network settings 
manually.

Static IP input varies, depending on your boot image. Linux images require that 
you enter a host name.

• Boot Image - Select the boot image corresponding to the OS you are installing.

• Provisioning Network - Select the NIC to be used for provisioning.

• Custom Attributes - Optionally specify custom attributes. For more information on 
custom attributes, see the SA User Guide: Server Automation.

11 Preview: Verify all your VM settings. Use the Back button or select any step to make 
changes, then select Next.

12 Scheduling: Select when you want the create VM job to run, then select Next.

13 Notifications: Optionally enter a notifier, then select Next. 

14 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it creates the VM and displays the results. Once the VM is created, 
you will see it in the virtualization inventory of the VS in the SA Client and All Managed 
Servers. 

Best Practice: If you provision Linux VMs, you should periodically delete the ISO files from 
the VM folder on the hypervisor.

Best Practice: It is highly recommended that you make all VMs into agent-managed servers 
to have maximum visibility, control, and compliance for these VMs. The easiest way is to 
install the OS using an OS Build Plan, which automatically installs the SA agent. For 
information about installing the SA agent, see Install the SA Agent on a VM on page 54 and 
the SA User Guide: Server Automation. For more information about OS Build Plans, see the 
SA User Guide: OS Provisioning.
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Deploy a VM from a VM Template - vCenter 

This section describes how to deploy a VM from a VM template. You can also create a VM from 
scratch or clone a VM from another VM. See Create and Provision a VM - vCenter on page 45 
and Clone a VM - vCenter on page 53.

Best Practice: Use an agent-managed template. 

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM template.

3 Select the VM template and right-click or select the Actions menu. Select Deploy VM to 
display the Deploy VM from VM Template window, as shown below.

4 Virtual Machine Definition: Enter the following information, then select Next.

• The VM name. 

• Select a customer to assign the VM to. You can select the customer; the default option 
is the customer assigned to the template.

The defaults for customer, inventory location, host, resource pool, and storage location 
are the same as the source. 

• Verify or change the location in the virtualization inventory where you want to place 
the new VM.

5 Host: Navigate to and select the server that you want to host the VM. Verify that the host 
is compatible, then select Next.

6 Resource Pool: If the host or cluster has resource pools defined, navigate to and select 
the resource pool where you want to place the new VM. Examine the Compatibility 
Details to make sure the resource pool can support the new VM, then select Next.
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7 Storage Location: Select the datastore in which to store the VM configuration file and 
the VM disk files.

a In Basic mode, select the datastore where all the VM related files will go (the VM 
configuration file and the VM disk files).

b In Advanced mode, you can select different datastores for the VM configuration file 
and for each of the VM disk files. Select the VM configuration file or any disk, then 
select the datastore from the drop-down list of available datastores.

c In either mode, you can also use the disk format.

Verify that the specified storage location is compatible with the VM you are creating, then 
select Next.

8 Guest Customization: Guest customization is strongly recommended and is available on 
agent-managed templates.

Guest customization is supported on the following platforms: 
- CentOS 5.8 and above
- OEL 5.8 and above
- Red Hat 5 and above
- SLES versions 10 and 11
- Windows 2008 32-bit
- Windows 2008 R2 x64
- Windows 2008 x64
- Windows 2012 x64

Set the following for the new VM:

— Windows: Enter the computer name for the new VM. Configure the network 
interfaces. Specify the Windows license key, administrator password, and network 
membership for the new VM. Optionally set custom attributes for the new VM.

— For Windows guests only—Determine which drive the system partition is using. If the 
source Windows VM has more than one partition (for example, a “Reserved Partition,” 
which default Windows installations have), you must set a custom attribute called 
“SystemPartition” on the source to specify the partition in which the system files 
reside. For example, if you have two partitions (Reserved and OS), set the 
“SystemPartition” drive custom attribute to D. 

Use the source volume license key, or optionally enter the product key as XXXXX–
XXXXX–XXXXX–XXXXX–XXXXX, in which each X represents a letter or number. 

— Linux: Enter the host name and domain name for the new VM. Configure the network 
interfaces. Enter the IP address of the DNS server. Optionally set custom attributes 
for the new VM. 

9 Preview: Verify the information about the VM to be deployed. Use the Back button or 
select a previous step to make changes, the select Next.

10 Scheduling: Select when you want the deploy VM job to run, then select Next.

11 Notifications: Optionally enter a notifier, then select Next. 

12 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it deploys the VM and displays the results. Once the VM is deployed, 
you will see it in the virtualization inventory of the VS in the SA Client and All Managed 
Servers.
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Deploy a VM from a VM Template - SCVMM

This section describes how to create a VM from a VM template. You can also create a VM from 
scratch (see Create and Provision a VM - SCVMM on page 48). 

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM template.

3 Select the VM template and right-click or select the Actions menu and select Deploy VM 
to display the Deploy VM from VM Template window.

4 Virtual Machine Definition: Enter the following information, then select Next.

• The VM name.

• A description of the VM. 

• Assign a customer to the VM. You can select the customer; the default option is the 
customer assigned to the template. 

5 Host: Select the server that you want to host the VM. Verify the host ratings, then select 
Next.

6 Storage Location: Select from the default paths configured on the host or enter a valid 
path that exists on the host.

7 Network Configuration: Select the network and optionally configure the VLAN ID for 
each NIC. 

8 Guest Customization: Guest customization is strongly recommended and is available on 
agent-managed templates. 

Guest customization is supported on the following platforms: 
- CentOS 5.8 and above
- OEL 5.8 and above
- Red Hat 5 and above
- SLES versions 10 and 11
- Windows 2008 32-bit
- Windows 2008 R2 x64
- Windows 2008 x64

Set the following for the new VM: 

— Windows: Enter the computer name for the new VM. Specify the Windows license key, 
administrator password, and network membership for the new VM. Optionally set 
custom attributes for the new VM. 

— For Windows guests only—Determine which drive the system partition is using. If the 
source Windows VM has a “Reserved Partition,” you must set a custom attribute 
called “SystemPartition” on the source to specify the drive. If you have two partitions 
(Reserved and OS), set the “SystemPartition” drive attribute to D. 

Enter the product key as XXXXX–XXXXX–XXXXX–XXXXX–XXXXX, in which each X 
represents a letter or number.

— Linux: Enter the host name and domain name for the new VM. Enter the IP address 
of the DNS server. Optionally set custom attributes for the new VM. 

9 Preview: Verify the information about the VM to be deployed. Use the Back button or 
select a previous step to make changes, the select Next.
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10 Scheduling: Select when you want the deploy VM job to run, then select Next.

11 Notifications: Optionally enter a notifier, then select Next. 

12 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it deploys the VM and displays the results. Once the VM is deployed, 
you will see it in the virtualization inventory of the VS in the SA Client and All Managed 
Servers. 

Clone a VM - vCenter 

Cloning a VM creates an exact copy of the original VM. It is recommended that you primarily 
use VM templates to create VMs to ensure the VMs are consistent and maintainable.

To clone a VM, the source VM must be agent-managed. For information about installing the 
SA agent, see Install the SA Agent on a VM on page 54 and the SA User Guide: Server 
Automation.

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to clone.

3 Select the desired VM and right-click or select the Actions menu. Select VM Manage > 
Clone to display the Virtual Machine Definition window.

4 Virtual Machine Definition: Enter the following information, then select Next.

• The VM name.

• Select a customer to assign the VM to. You can select the customer; the default option 
is the customer assigned to the source VM. 

The defaults for customer, inventory location, hypervisor, resource pool, and storage 
location are the same as the source.

• Verify or change the location in the virtualization inventory where you want to place 
the new VM.

5 Host: Navigate to and select the Host where you want the new VM to run. Examine the 
Compatibility Details to make sure the host can support the new VM. Note that 
compatibility can only be checked if the VM being cloned is powered off. 

6 Resource Pool: If the host has resource pools defined, select the resource pool where you 
want to place the new VM. Examine the Compatibility Details to make sure the resource 
pool can support the new VM, then select Next. Note that compatibility can only be 
checked if the VM being cloned is powered off. 

7 Storage Location: Select the datastore in which to store the VM configuration file and 
the VM disk files.

a In Basic mode, select the datastore where all the VM related files will go (the VM 
configuration file and the VM disk files).

b In Advanced mode, you can select different datastores for the VM configuration file 
and for each of the VM disk files. Select the VM configuration file or any disk, then 
select the datastore from the drop-down list of available datastores.

c In either mode, you can also use the disk format.
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Verify that the specified storage location is compatible with the VM you are creating, then 
select Next.

8 Guest Customization: Guest customization is strongly recommended and is available on 
agent-managed templates.

Guest customization is supported on the following platforms: 
- CentOS 5.8 and above
- OEL 5.8 and above
- Red Hat 5 and above
- SLES versions 10 and 11
- Windows 2008 32-bit
- Windows 2008 R2 x64
- Windows 2008 x64
- Windows 2012 x64

Set the following for the new VM:

— Enter the computer name for the new VM. Specify the Windows license key, 
administrator password, and network membership for the new VM. Optionally set 
custom attributes for the new VM.

— For Windows guests only—Determine which drive the system partition is using. If the 
source Windows VM has a “Reserved Partition,” you must set a custom attribute 
called “SystemPartition” on the source to specify the drive. If you have two partitions 
(Reserved and OS), set the “SystemPartition” drive attribute to D. 

Enter the product key as XXXXX–XXXXX–XXXXX–XXXXX–XXXXX, in which each X 
represents a letter or number.

— Linux: Enter the host name and domain name for the new VM. Enter the IP address 
of the DNS server. Optionally set custom attributes for the new VM. 

9 Preview: Verify the selections listed. Use the Back button or select any previous step to 
make changes, then select Next.

10 Scheduling: Select when you want the clone VM job to run, then select Next.

11 Notifications: Optionally enter a notifier, then select Next. 

12 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it clones the VM and displays the results. Once the VM is created, you 
will see it in the virtualization inventory of the VS in the SA Client and All Managed 
Servers. 

Install the SA Agent on a VM

To gain the most benefit from SA, you should always install the SA agent on all managed 
servers, both VMs and physical servers.

If you created the VM from an agent-managed server or an agent-managed VM template, the 
SA agent is already installed on the VM. You only need to install the SA agent if you created a 
VM without an SA agent.
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To determine if the SA agent is running on a VM (or any server), locate the VM or server in 
the SA Client and hover your mouse pointer over the icon for the server. The SA Client will 
display the agent status of the server, either agentless or agent managed. You can also select 
or open the server in the SA Client, and select the Summary view. This view gives the status 
of the SA agent.

For more information about the SA agent, agent-managed servers, and installing the agent on 
multiple servers, see the SA User Guide: Server Automation.

To install the SA agent on a VM, perform the following steps:

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM on which you want to install the SA agent.

3 Select the desired VM and right-click or select the Actions menu. Select Install SA 
Agent to display the Install SA Agent window.

4 Enter the IP address of the VM.

5 Select Scan. SA attempts to establish communications with the VM and determines the 
best protocol to use to install the SA agent. If the scan fails, check the power status and 
network settings of the VM.

6 Select a network protocol to connect to the VM from the drop-down list.

In most cases, you should choose Select Automatically to allow SA to select an appropriate 
protocol for the VM.

7 Enter a user name and password to use for logging into the VM. 

For Windows-based systems, specify the Windows administrator user name and 
password. 

For UNIX systems, specify a root user and password. If logging in as root is not 
permitted, select the check box Become root (UNIX). Select Supply root password and 
enter the password, or select Use sudo if sudo access is enabled for that account.

If you log in using sudo, the sudo user’s configuration file (typically /etc/sudoers) must 
allow the account to run any command with root privileges. This is typically accomplished 
by using the “ALL” alias in the sudoers file.

If you are unable to deploy the agent to a UNIX server by logging in as root, the system 
you are deploying to may be configured to disallow direct root logins. In such cases, SA 
allows you to log in as a non-root user and then escalates your privileges using either the 
“su” or the “sudo” command.

Perform the following steps to deploy agents as non-root users:

a Enter the non-root user name in the Username field to log into the server.

b Enter the non-root password in the Password field.

c Select the Become root (UNIX) check box. Select “Supply root password” and enter the 
password or select “Use sudo.” If you use sudo, the non-root account must be able to 
run any command as root.

8 Select one of the following deployment actions:

• Verify installation prerequisites.

Checks for sufficient disk space for agent installation on the VM, verifies that no other 
applications are using port 1002, and verifies that ports to the SA gateway are 
accessible.

• Verify prerequisites and copy agent installer to servers.
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Copies the agent installer to the VM.

• Verify prerequisites, copy installer, and install agent.

Installs the SA agent on the VM.

9 Optionally specify the agent installer options and advanced options to control the way the 
agent is installed on a server. See the SA User Guide: Server Automation for more 
information.

10 Select OK to perform your selected actions.

11 After the deployment action is completed, the SA Client displays the results and updates 
the status icons for the VM. 

For more information on agent installation status and troubleshooting, see the SA User 
Guide: Server Automation.

Modify a VM - vCenter and SCVMM 

A VM must be powered off before it can be modified. For more information, see Power On/Off 
a VM - vCenter and SCVMM on page 60.

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to modify. Make sure it is powered off. 

3 Select the desired VM and right-click or select the Actions menu. Select VM Manage > 
Modify to display the Virtual Machine Definition window, as shown below.

4 Virtual Machine Definition: Change the VM name, description, memory size, number 
of virtual processors or the guest operating system setting, then select Next.
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5 Storage Configuration: Use the  and  buttons to add or remove storage for the 
VM. Select any storage item to modify its settings, then select Next.

6 Network Configuration: Use the  and  buttons to add or remove NICs. Select a 
NIC to change its settings, then select Next.

7 Integration Services: For SCVMM only, select the desired services for the VM, then 
select Next.

8 Advanced Options: Set the following, then select Next.

— vCenter - Set the power on boot delay time, if desired. 

— SCVMM - Set the start and stop options and the boot order, if desired.

9 Preview: Verify the information about the VM. Use the Back button or select a previous 
step to make changes, then select Next.

10 Scheduling: Select when you want the modify VM job to run, then select Next.

11 Notifications: Optionally enter a notifier, then select Next. 

12 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it modifies the VM and displays the results.

Migrate a VM - vCenter 

You can migrate a VM to run on a different host, migrate a VM’s storage to a different storage 
location, or migrate the VM to a different resource pool. To migrate a VM, it must be powered 
off or suspended. For more information, see Power On/Off a VM - vCenter and SCVMM on 
page 60 and Suspend a VM - vCenter and SCVMM on page 61.

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to migrate. If the VM is powered on, power it off or suspend 
it.
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3 Select the desired VM and right-click or select the Actions menu. Select VM Manage > 
Migrate to display the Migration Type window, as shown below.

4 Migration Type: Select the type of migration you want, then select Next. You can change 
the VM host, or the VM storage, or both. The next window or windows depend on the type 
of migration you selected. Check all of the following windows that apply to your situation:

5 Destination: Change the host to which you want to migrate the VM. Examine the 
Compatibility Details to make sure the selected location can support the VM, and select 
Next.

6 Resource Pool: Change where you want to place the VM. Examine the compatibility 
details to make sure the resource pool can support the VM, and select Next.

7 Storage Location: Select the datastore in which you want to store the VM configuration 
file and the VM disk files. Verify that the specified storage location is compatible with the 
VM you are migrating, and select Next.

— Select the format for the virtual disk. You can specify the same format as the source 
disk, thin provisioned, or thick provisioned with lazy zeroing. If the VM has multiple 
disks, this setting only applies to disks being migrated to another datastore. It will not 
change the format for disks not being migrated to another datastore.

— In Basic mode, select the datastore where all the VM related files will go (the VM 
configuration file and the VM disk files).

— In Advanced mode, you can select different datastores for the VM configuration file 
and for each of the VM disk files. Select the VM configuration file or any disk, then 
select the datastore from the drop-down list of available datastores. 

8 Preview: Verify the changes. Use the Back button or select a previous step to make 
changes, then select Next.

9 Scheduling: Select when you want the migrate VM job to run, then select Next.

10 Notifications: Optionally enter a notifier, then select Next. 
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11 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it migrates the VM and displays the results.

Migrate a VM - SCVMM 

You can migrate a VM to run on a different host or you can migrate a VM’s storage to a 
different storage location. To migrate a VM, it must be powered off or suspended. For more 
information, see Power On/Off a VM - vCenter and SCVMM on page 60 and Suspend a VM - 
vCenter and SCVMM on page 61. 

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to migrate. If the VM is powered on, power it off or suspend 
it. 

3 Select the desired VM and right-click or select the Actions menu. Select VM Manage > 
Migrate to display the Migration Type window, as shown below. 

4 Migration Type: Select the type of migration you want, then select Next. The next 
window or windows depend on the type of migration you selected. Check all of the 
following windows that apply to your situation: 

5 Host: Select the host to which you want to migrate the VM. Check the host rating details 
to verify the destination host is compatible, and select Next.

6 Storage Location: Enter the path on the host where you want to place the VM file and 
the VM disk files, then select Next. You can specify a different location for each disk.

7 Network Configuration: For each NIC, use the drop-down menu to select the network 
to which you want to connect the VM, and select Next.
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8 Preview: Verify the changes listed. Use the Back button or select a previous step to make 
changes, then select Next. 

9 Scheduling: Select when you want the migrate VM job to run, then select Next. 

10 Notifications: Optionally enter a notifier, then select Next. 

11 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab. 

When the job runs, it migrates the VM and displays the result. 

Delete a VM - vCenter and SCVMM 

To delete a VM, the SA agent on the VM must be deactivated, and the VM must be powered 
off. You can delete several VMs at once. For more information, see Deactivate the SA Agent on 
a VM - vCenter and SCVMM on page 64 and Power On/Off a VM - vCenter and SCVMM on 
page 60.

To delete a VM, perform the following steps:

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to delete. If the VM is agent-managed, deactivate the agent. 
If the VM is powered on, power it off.

3 Select the desired VM and right-click or select the Actions menu and select VM Manage 
> Delete to display the Delete Virtual Machines window.

4 Delete Virtual Machines: Verify the VM that you want to delete, then select Next. Or 
you can select Start Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the delete VM job to run, then select Next.

6 Notifications: Optionally enter a notifier, then select Next.

7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it deletes the VM and displays the results.

Power On/Off a VM - vCenter and SCVMM 

To power a VM on or off, perform the following steps:

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to power on or off.
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3 You can power on or power off several VMs at once. Select the desired VM(s) and 
right-click or select the Actions menu. Select VM Power > Power On or Power Off to 
display the Run Power Control window, as shown below. 

4 Run Power Control: Verify the VM you want to power on or off, then select Next. Or you 
can select Start Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the power control job to run, then select Next.

6 Notifications: Optionally enter a notifier, then select Next.

7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it powers the VM on or off and displays the results.

Suspend a VM - vCenter and SCVMM 

Suspending a VM pauses the virtual machine activity. All transactions are frozen until you 
power on the VM. Consumed host memory and CPU are released back to host.

To suspend a VM, perform the following steps:

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to suspend.

3 Select the desired VM and right-click or select the Actions menu and select VM Power > 
Suspend to display the Run Power Control window.

4 Run Power Control: Verify the VM you want to suspend, then select Next. Or you can 
select Start Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the suspend job to run, then select Next.

6 Notifications: Optionally enter a notifier, then select Next.
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7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it suspends the VM and displays the results.

Use Power On to restart a suspended VM. For more information, see Power On/Off a VM - 
vCenter and SCVMM on page 60.

Pause a VM - SCVMM

Pausing a VM suspends execution of the VM and keeps all VM state in memory. 

To pause a VM, perform the following steps:

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to pause.

3 Select the desired VM and right-click or select the Actions menu. Select VM Power > 
Pause to display the Run Power Control window.

4 Run Power Control: Verify the VM you want to pause, then select Next. Or you can 
select Start Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the pause job to run, then select Next.

6 Notifications: Optionally enter a notifier, then select Next.

7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it pauses the VM and displays the results.

Use Power On to resume a paused VM. For more information, see Power On/Off a VM - 
vCenter and SCVMM on page 60.

Reset a VM - vCenter 

Resetting a VM stops the VM and restarts (reboots) it.

Use care when resetting a VM because it performs a hard shut down.

To reset a VM, perform the following steps:

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to reset.

3 Select the desired VM and right-click or select the Actions menu. Select VM Power > 
Reset to display the Run Power Control window.

4 Run Power Control: Verify the VM you want to reset, then select Next. Or you can 
select Start Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the reset job to run, then select Next.
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6 Notifications: Optionally enter a notifier, then select Next. 

7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it resets the VMs and displays the results.

Shut Down a VM Guest OS - vCenter and SCVMM 

To shut down the guest operating system of the VM, the guest tools must be installed on the 
VM. For more information on guest tools, see the virtualization vendor’s documentation.

To shut down the guest operating system of the VM, perform the following steps:

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VMs you want to shut down.

3 Select the desired VMs and right-click or select the Actions menu. Select VM Power > 
Shut down guest to display the Run Power Control window.

4 Run Power Control: Verify the VM you want to shut down, then select Next. Or you can 
select Start Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the shut down job to run, then select Next.

6 Notifications: Optionally enter a notifier, then select Next.

7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it shuts down the VM operating system and displays the results.

Use Power On to restart a VM that has been shut down. For more information, see Power On/
Off a VM - vCenter and SCVMM on page 60.

Restart a VM Guest OS - vCenter

To stop and restart the guest operating system of the VM, the guest tools must be installed on 
the VM. For more information on guest tools, see the virtualization vendor’s documentation.

To stop and restart the guest operating system of the VM, perform the following steps.

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VMs you want to restart.

3 Select the desired VMs and right-click or select the Actions menu. Select VM Power > 
Restart guest to display the Run Power Control window.

4 Run Power Control: Verify the VM you want to restart, then select Next. Or you can 
select Start Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the restart job to run, then select Next.

6 Notifications: Optionally enter a notifier, then select Next. 
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7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it stops and restarts the VM operating system and displays the 
results.

Deactivate the SA Agent on a VM - vCenter and SCVMM

Deactivating the SA agent on a virtual machine is the same as deactivating the agent on a 
physical machine: it makes the server no longer agent-managed. Virtual servers that are not 
agent-managed can still be managed by a Virtualization Service. 

This is the same process used for physical servers, which are accessed under the Devices tab. 
For more information about the SA agent and agent-managed servers, see the SA User Guide: 
Server Automation.

To deactivate the SA agent on a VM, perform the following steps.

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the agent-managed VM you want to deactivate.

3 Select the desired VMs and right-click or select the Actions menu and select Deactivate 
SA Agent.

4 Verify that you want to deactivate the agent on the VM and select Deactivate. This stops 
the SA agent on the server.

Convert a VM to a VM Template - vCenter 

You can convert VM information to a VM template and then deploy VMs from the VM 
template. For more information, see Deploy a VM from a VM Template - SCVMM on page 52.

To convert a VM to a VM template, the VM must be agent-managed and powered off. For more 
information, see Install the SA Agent on a VM on page 54 and Power On/Off a VM - vCenter 
and SCVMM on page 60.

To convert a VM to a VM template, perform the following steps.

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to convert to a VM template. If the VM is powered on, power 
it off. 

3 Select the desired VM and right-click or select the Actions menu. Select VM Manage > 
Convert to VM Template to display the Convert VM to VM Template window.

4 Convert VM to VM Template: Verify the VM you want to convert to a VM template, 
then select Next. Or you can select Start Job to accept the remaining defaults and run the 
job.

5 Scheduling: Select when you want the job to run, then select Next.

6 Notifications: Optionally enter a notifier, then select Next. 
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7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it converts the VM to a VM template and displays the results.

Convert a VM to a VM Template - SCVMM 

You can convert VM information to a VM template and then deploy VMs from the VM 
template. For more information, see Deploy a VM from a VM Template - vCenter on page 50. 

To convert a VM to a VM template, the VM must be agent-managed and powered off. For more 
information, see Install the SA Agent on a VM on page 54 and Power On/Off a VM - vCenter 
and SCVMM on page 60.

To convert a VM to a VM template, perform the following steps.

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM you want to convert to a VM template. If the VM is powered on, power 
it off.

3 Select the desired VM and right-click or select the Actions menu. Select VM Manage > 
Convert to VM Template to display the Convert VM to VM Template window.

4 Convert VM to VM Template: Verify the VM you want to convert to a VM template. 
Specify the Library Server to which you want to store the template and enter the location, 
which must be an existing path. Or you can select Start Job to accept the remaining 
defaults and run the job. 

5 Scheduling: Select when you want the job to run, then select Next. 

6 Notifications: Optionally enter a notifier, then select Next.

7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it converts the VM to a VM template and displays the results.
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Delete a VM Template - vCenter and SCVMM 

Performing the Delete a VM Template action deletes a template or templates permanently. 
You can delete several VM templates at once. 

1 In the SA Client, select the Virtualization tab to display your virtualization inventory.

2 Navigate to the VM template you want to delete.

3 Select the desired VM template and right-click or select the Actions menu. Select Delete 
VM Template to display the Delete VM Templates window.

4 Verify the VM templates that you want to delete, then select Next. Or you can select Start 
Job to accept the remaining defaults and run the job.

5 Scheduling: Select when you want the delete VM template job to run, then select Next.

6 Notifications: Optionally enter a notifier, then select Next.

7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it deletes the VM template and displays the results.
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8 Managing HP-UX Virtual Servers
This section describes how to use the SA web extension to create and manage HP-UX VMs, 
HP-UX Virtual partitions, and HP Integrity Virtual machines.

Terms and Definitions

• HP-UX Virtual Partitions (vPars containers) - vPars containers enables you to run 
multiple instances of HP-UX simultaneously on one hard partition by dividing that hard 
partition further into virtual partitions. Each virtual partition is assigned its own subset 
of hardware, runs a separate instance of HP-UX, and hosts its own set of applications. 
Because each instance of HP-UX is isolated from all other instances, vPars provides 
application and operating system (OS) fault isolation. Each instance of HP-UX can have 
different patches and a different kernel.

• HPVM Hypervisors - HPVM hypervisors are soft partitioning and virtualization 
technologies that provides operating system isolation, with sub-CPU allocation 
granularity and shared I/O. HPVM hypervisors can be installed on an Integrity server, 
Integrity server blade, or hardware partition (nPartition) running HP-UX. The HPVM 
hypervisor environment consists of two types of components:

— HPVM Host

— VMs (also called guests)

• HPVM Hypervisor Host (Host) - The HPVM hypervisor host virtualizes physical 
processors, memory, and I/O devices, allowing you to allocate them as virtual resources to 
each virtual machine.

• HPVM - Individual VMs, components of the HPVM Hypervisor.

• vPars - Individual vPars, components of the vPars Container.

• vSwitches - Virtual switches.

Requirements

The following are requirements for HP-UX virtualization:

• For both vPars and HPVM hypervisors:

— Make all host servers (HP-UX servers) managed servers on HP Server Automation. 
For more information, see the SA User Guide: Server Automation.

• For vPars:

— Install the Virtual Partitions product on the host server. See “Virtual Partitions” in: 
http://docs.hp.com/hpux/11iv3.
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• For HPVM hypervisors:

— Install the HP Integrity Virtual Machine product on the host server. See “HP Integrity 
Virtual Machines and Online VM Migration” in: http://docs.hp.com/hpux/11iv3.

Supported Platforms and Configurations

Managing HP-UX virtual servers using SA supports the following platforms and 
configurations:

Not Supported

Cloning and migration of VMs are not supported by the HP-UX Virtualization Manager. 
However, they are supported by HP Integrity Virtual Machines. 

SA Permissions Required

This section describes the SA permissions required for HP-UX use. For complete information 
on permissions, see the SA Administration Guide.

Virtualization Service Management Permissions 

Table 39 and Table 40 of the SA Administration Guide provide details on permissions 
required for HP-UX use. Not all of these permissions apply to HP-UX; check these tables for 
more detailed information. 

Table 8 Supported Platforms and Configurations

Platform or Configuration Support

Virtualization Platforms vPars A.5.06 and later versions

HPVM hypervisors 4.2 and later versions

HP-UX guest OS 11iV3

HP-UX Host OS for IVM and first vPars on 
physical server

11iV3

Processor Architecture Itanium

SA Version 9.04 CORD release

SA platform RHEL AS4 – 64bit

Satellite and Multi-master support RHEL AS4 – 64bit

Integrity platform support As defined by the vPars and HPVM support 
matrix.
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Action Permissions Required

To manage HP-UX VMs, your SA user must either belong to an SA user group that has the 
following action permissions or have the permissions:

Folder Permissions Required

You need access to the SA Library folder containing the HP-UX Virtualization Manager web 
extension to manage HP-UX VMs and run the web extension. This web extension is located in 
the SA Library folder /Opsware/Tools/Virtualization Programs. For complete 
information on folder permissions, refer to the SA Administration Guide.

Use the following procedure to assign the required folder permissions to a user:

1 Log in to the SA Client as an administrative user that has permission to set folder 
permissions.

2 In the SA Client, select the Library tab.

3 Select the By Folder tab to display the SA Library folder structure.

4 Navigate to the folder: /Opsware/Tools/Virtualization Programs.

5 Right-click Virtualization Programs and select the Folder Properties menu. This displays 
the Folder Properties window.

6 In the Folder Properties window, select the Permissions tab. This displays the user groups 
that have some permissions to the folder.

7 Select the user group you want to grant access to. If the user group does not appear, select 
the Add button to add it.

8 Select Execute Objects Within Folder.

9 Select OK.

Table 9 Action Permissions Required for Managing HP-UX VMs

Permission Tab Setting User Action Enabled

System Administration:
Managed Servers and Groups

Yes View managed servers and device groups

Virtualization:
View Virtualization Inventory

Yes View HPVM hypervisors, HPVMs, vPars 
containers, vPars, and vSwitches

Discover and refresh HPVM hypervisors

Virtualization:
Manage VM Lifecycle: Create VM
Manage VM Lifecycle: Modify VM
Manage VM Lifecycle: Delete VM

Yes Create, modify, and remove HPVM 
hypervisors, vPars containers, vPars, 
vSwitches, and HPVMs

Virtualization:
Manage VM Power State

Yes Shut down, halt, and start HPVMs, 
vPars, and vSwitches
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Resource Permissions Required

As with all server management tasks, you need access to the HP-UX servers. Grant access to 
the facility, customer and at least one device group of your HP-UX managed servers. For 
complete information on resource permissions, see the SA Administration Guide.

Server and Switch Status Icons

This section describes the icons associated with HPVM hypervisors and vPars containers.

Table 10 describes the vPar container and HPVM hypervisor status icons (displayed in the 
HP-UX Virtualization Manager web extension) and their meaning:

Table 11 shows the vSwitch icons displayed in the HP-UX Virtualization Manager web 
extension and their meanings.

Table 10 Status Icons

Icon
Icon Meaning for vPars 
Containers Icon Meaning for HPVM Hypervisor

Agent-managed

1 or more vPars reachable

Agent-managed and reachable

Agent-managed

Unreachable

Agent-managed but unreachable

Agentless (or HP-UX Virtualization 
Manager web extension not run while 
the server in nPars mode)

1 or more nPars reachable

Not applicable

Agentless (or HP-UX Virtualization 
Manager web extension not run while 
the server in vPars mode)

Unreachable

Not applicable

Table 11 vSwitch Icons

Icon Icon Meaning for vSwitches

Status is Up

Status is not Up
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Quick Start vPars, HPVMs, and vSwitches

This section describes prerequisites for using HP-UX Virtualization Manager web extensions:

1 Make sure that your HP-UX servers are agent-managed by SA and visible in the SA client 
under Devices > All Managed Servers. For more information, see the SA User Guide: 
Server Automation.

2 Make sure that your SA user has adequate permissions. For details, see SA Permissions 
Required on page 68.

Prerequisites for managing vPars, HPVMs, or vSwitches:

1 Manage your vPars as described in Managing vPars Containers on page 80.

2 Manage your HPVMs as described in Managing HPVM Hypervisors on page 84.

3 Manage your vSwitches as described in Managing vSwitches on page 91.

Launching the HP-UX Virtualization Manager

To launch the HPVM manager:

1 In the SA Client, in the left panel, choose Library > Extensions > Web.

2 In the Web panel, double-click the HP-UX Virtualization Manager icon to display the 
HP-UX Virtual Servers window, which lists HPVM hypervisors and vPars containers.

Saving ioscan Output

For vPars, ioscan output can only be obtained when the nPar or physical server is in nPars 
mode. 

The following procedure saves a copy of the ioscan output, makes the output viewable, and 
simplifies the process of creating and modifying vPars. You will need to repeat these steps to 
refresh the ioscan output if you add or remove input/output information.

1 Boot the server to nPars mode.

2 Follow the steps in Launching the HP-UX Virtualization Manager on page 71 to display 
the HP-UX Virtual Servers window.

3 If the server is already displayed on the main page, the ioscan output has been saved.

4 If the server is not displayed, add the server to the main page (see Adding an HPVM 
Hypervisor/vPars Container on page 78).

The saved ioscan output can now be viewed at any time. However, if I/O on the server is added 
or removed, you must repeat steps 1- 4 above to refresh the ioscan output.

The ioscan output displayed in this view can also be used to simplify the creation and 
modification of vPars.
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Viewing Summary, Hardware, and ioScan Information

This section describes how to view information for HPVM hypervisors/vPars containers/
HPVMs/vPars, and vSwitches.

To view information:

1 Follow the steps in Launching the HP-UX Virtualization Manager on page 71 to display 
the HP-UX Virtual Servers window.

2 Double-click HP-UX Virtualization Manager to display the HP-UX Virtual Servers 
window, which contains a list of HPVM hypervisors/vPars containers associated with that 
manager.

To view individual HPVMs/vPars/vSwitches, click the arrow to the left of the HPVM 
hypervisor/vPars container associated with that individual component.
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3 To display summary information for a selected HPVM hypervisor/vPars container/HPVM/
vPars/vSwitch, choose View > Summary and then select the HPVM hypervisor/vPars 
container/HPVM/vPars/vSwitch to display its summary information in the bottom 
summary panel.

Table 12 HPVM Hypervisor/vPars Containers/HPVMs/vPars/vSwitches 
Information

Property Description

Name Name, as designated when the HPVM 
hypervisor/vPars container was added to the 
HP-UX Virtualization Manager

Status Status (whether the HPVM hypervisor/vPars 
container is reachable from the SA Client 
core or not)

Status = Unreachable or

Status = vPars (for vPars mode); Physical 
Server (for nPars mode or HPVM) 

For individual vPars and vSwitches, status = 
Up/Down

For individual HPVMs, status = On/Off

Type Whether the HPVM hypervisor or vPars 
container is running the vPars or HPVM 
software

Hostname Hostname of:

— HPVM hypervisor or vPars container

— HPVM or vPars that has become a 
managed server in the SA Client

Note: Hostname = - (dash) if HPVM or vPars 
is not a managed server

IP Address Individual HPVM hypervisor/vPars 
container /HPVM/vPars IP address

Note: Value is blank if HPVM is not an 
SA-managed server

Facility Physical location of the HPVM hypervisor/
vPars container host machine

Customer Assigned customer
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Summary information includes:

Table 13 Summary Information

Property Description

ID Identification number in the SA Client

Status Status (whether the HPVM hypervisor/vPars 
container/HPVM/vPars/vSwitch is reachable 
from the SA Client core or not)

Status = Unreachable or

Status = vPars (for vPars mode); Physical 
Server (for nPars mode or HPVM) 

For individual vPars and vSwitches, status = 
Up/Down

For individual HPVMs, status = On/Off

Lifecycle Managed by the SA Client or not

Manufacturer Name of the manufacturer

OS Version Version

Serial Serial number
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4 To display hardware information for a selected HPVM hypervisor/vPars container/
HPVMs/vPars, choose View > Hardware.

Hardware information includes:

Table 14 HPVM Hypervisor Hardware Information

Property Description

Available CPUs Number of CPUs assigned

Available CPU speed for an HPVM CPU speed available for HPVMs associated 
with that HPVM hypervisor/vPars container

Total Physical Memory Total physical memory associated with the 
HPVM hypervisors/vPars container

Available memory for a HPVM Memory available for a particular HPVM 
associated with the HPVM hypervisors/
vPars container

Table 15 vPars Container Hardware Information

Property Description

Available CPUs Number of CPUs assigned

Available Interleaved Memory Amount of non-cached memory available to 
the vPars container

Available Cell - Memory Amount of memory available per cell (series 
of comma-separated <cell number>:<memory 
size>)

Available Cell - CPU Indicates the number of CPUs available per 
cell (a series of comma-separated <cell 
number>:<number of CPUs>)
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5 To display information about the devices connected to a selected HPVM hypervisors/vPars 
container/HPVM/vPars machine, such as storage, disk, memory, and processor 
information, choose View > IO Scan.

The IO Scan view shows the output from the HP-UX ioscan(1M) command for the selected 
vPars container or HPVM. 

To rearrange ioScan output columns, drag and drop them. To sort by column, select the 
column header. To sort by additional columns, hold down the Ctrl key while selecting the 
column header.

Table 16 vPars Hardware Information

Property Description

Assigned CPUs Number of CPUs assigned to vPars

Assigned Total Memory Amount of assigned memory for vPars

Cell - CPU Number of available cell CPUs

Cell - Memory Amount of cell memory available

Primary Boot Disk Name of the primary boot disk

Alternate Boot Disk Name of the alternate boot disk

Number of Local Bus Adapter(s) Number of local bus adapters for vPar

Local Bus Adapter(s) Name of the local bus adapters

Table 17 HPVM Hardware Information

Property Description

Assigned CPUs Number of CPUs assigned to HPVM

Assigned Memory Amount of memory assigned to HPVM

Assigned vSwitches vSwitches assigned to HPVM, in a list of 
comma-separated <port> - <HPVM> 
associated with the vSwitch

Assigned Storage Amount of storage assigned to the HPVM

Table 18 vSwitch Hardware Information

Property Description

Assigned LAN interface LAN interface assigned to the vSwitch

Assigned Ports Ports assigned exclusively to the vSwitch
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6 IOScan information (which is applicable only to HPVM hypervisors and vPars containers) 
includes:

Table 19 IO Scan Information

Property Description

Class Device class

Instance Instance

Hardware Path Hardware path to the device

Driver Driver associated with the device

Software State

(of devices attached to the machine)

CLAIMED = device software bound 
successfully

NO-HW = device hardware is no longer 
responding

Description Device description (for example, whether it is 
an adapter or processor)

Device Special Files Device filename (as identified by the system)
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Adding an HPVM Hypervisor/vPars Container

To add an HPVM hypervisor or vPars container to HP-UX Virtualization Manager 
management:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to display the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, select the HPVM hypervisor to associate with the 
new HPVM.

3 Click .

The Add Virtual Servers window is displayed.

4 In the Virtual Servers window, choose the following HPVM search criteria (you can use 
wildcards to search):

Table 20 Add Virtual Servers Search

Field Choice Displays

Main field

All All servers (including 
managed and virtual)

Explicit IPs/Hostname HPVM hypervisors by their 
IP address or hostname

Supply IP Address Range HPVMs within an IP address 
range

Search in All Facilities HPVMs at all facilities

<specific facility 
choice>

HPVMs at the specified 
facility

Display Virtual Servers only Only HPVMs

All Servers
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5 Click Search.

6 In the results field, select the HPVM(s) to be added.

7 Click Add Server to add the HPVM.

The new HPVM is added as a managed server in the list below its associated HPVM 
hypervisor/vPars container.

Configuring Server Timeouts

SA verifies connectivity with HP-UX virtual servers by pinging them. If a server is offline, the 
ping will time out and the server will be considered offline. By default the ping timeout value 
is 15 seconds. You can reduce the ping timeout and improve responsiveness on networks with 
low latency by setting the value of the custom attribute hpux_v12n_timeout.

You can configure the timeout value by setting a custom attribute named 
hpux_v12n_timeout. The default value is 15 seconds. You can set it to any integer from 1 to 
120.

For each server, SA searches the following objects in order for the custom attribute:

1 Server

2 Device group

3 Customer

4 Realm

5 Facility

6 OS

7 Software policy

For example, if you add the hpux_v12n_timeout custom attribute to the device group named 
“HP-UX 11.31”, all HP-UX 11.31 servers inherit that timeout value, unless they explicitly set 
the custom attribute at the server level.

Or to change the timeout value for all the servers that reside in a particular facility, add the 
custom attribute to that facility.

For more information on custom attributes, see the SA User Guide: Server Automation.

Custom Attributes that HP-UX Virtualization Manager Creates

The HP-UX Virtualization Manager creates the following custom attributes for internal 
management:

Table 21  HP-UX Virtualization Manager Custom Attributes

vPars/HPVM Attribute Value Description

vPars ioscan String 
(JSON format)

ioscan command output 
(enables server to be displayed 
in vPars mode)
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Managing vPars Containers

You can only create, use, and manage vPars containers on managed servers. See the SA User 
Guide: Server Automation for instructions on how to make a server a managed SA server.

Your HP-UX server must be in nPars mode or in vPars mode to use the HP-UX Virtualization 
Manager. You must use HP-UX commands and tools to switch between nPars mode and vPars 
mode. For more information, see the HP-UX Virtual Partitions documentation.

The following sections describe how to manage HP-UX virtual partitions. You can perform any 
of these operations on any vPars as long as at least one vPar in the vPar container is a 
managed server and is online.

Switching between nPars and vPars modes

To switch between nPars and vPars from the HP-UX shell:

Set the mode for the next nPartition reboot:

# vparenv [-m mode]

Where mode has the value of either vPars or nPars. This action might take a few minutes to 
process.

For example:

a Set the mode:

# vparenv -m vPars

b Manually reboot the nPartition:

# shutdown -r
...
Shell> fs0:
fs0:\> hpux/stand/vpmon
...
MON>

vPars nPar True True = server reboots while in 
nPars mode

vPars

HPVM

partition_ident:
<value>

True Partition identifier (identifies 
which servers are on the same 
partition)

vPars sa_vPars_hypervisor True True = server displayed on the 
HPUX Virtualization Manager 
main page

vPars vpar_name String Server’s vPars name.

Table 21  HP-UX Virtualization Manager Custom Attributes (cont’d)

vPars/HPVM Attribute Value Description
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To switch between nPars and vPars from the vPars monitor:

Reboot the nPartition into the mode mode:

reboot [mode]

Where mode is either vPars or nPars.

If any virtual partitions are up, issuing this command will cause them to be shutdown 
ungracefully.

To switch from the EFI, issue the following command:

Shell> fs0:
fs0:\. vparconfig reboot [mode]

Where mode is either vPars or nPars.

Creating a vPar

To create an HP-UX vPars virtual partition, perform the following steps.

1 Run the HP-UX Virtualization Manager as described in Launching the HP-UX 
Virtualization Manager on page 71.

2 Select an HP-UX server that is a vPars Container.

3 Right-click on the HP-UX server and select Create vPar. This displays the Create Virtual 
Partition window as shown below.

Figure 21 Create Virtual Partition Screen

4 Select the General tab and enter the vPars General settings:
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5 Select the CPU tab and enter the CPU settings:

Table 22 vPars General Settings

Property Description

vPars name Name, as designated when the vPars 
container was added to the HP-UX 
Virtualization Manager

vPar Boot Disk Setting Setting to automatically or manually boot 
the disk

Use the primary boot only or have alternate 
boot available.

Advanced Settings - Kernel path and 
Kernel Boot Options

Full kernel path and kernel boot options 
(optional)

Table 23 vPars CPU Settings

Property Description

CPU Number of CPUs to be allocated to the vPars

If the server is in nPars mode, the total 
available CPUs, remaining CPUs, number of 
cells and the default maximum number of 
CPUs are unknown.

The number of allocated CPUs must fall 
within the 'CPU Minimum'/'CPU Maximum' 
range.

A total of 16 cells will always be displayed in 
the table. 

Minimum Number of CPUs Minimum number of CPUs to allocate to the 
vPars

Maximum Number of CPUs Maximum number of CPUs to allocate to the 
vPars (default: 256)
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Select the Memory tab and enter the memory settings:

Select the Input/Output tab and set the I/O settings for the vPar:

If ioScan data is not available, the Available Hardware Inventory panel will be blank.

6 Click Submit to create the vPar virtual partition.

Modifying a vPar

To modify a vPar, right-click on a vPar and select Modify vPar. The Modify vPar window is 
generally the same as the Create vPar except that the current values of the vPar are filled in, 
and the memory and I/O settings cannot be modified if the vPar's status is Up.

Table 24 vPars Memory Settings

Property Description

Base Memory Amount of base memory to allocate to the 
vPars

If the server is in nPars mode, the 
Remaining Available memory and the 
number of cells are unknown.

A total of 16 cells will always be displayed in 
the table. 

Floating Memory Amount of floating memory to allocate to the 
vPars

Cell Local Memory Amount of cell local memory to allocate to 
the first vPars (optional)

Inter Leaved Memory Amount of inter-leaved memory to allocate to 
the first vPars (optional)

Table 25 vPars Input-Output Settings

Property Description

Primary boot disk Path to the primary boot disk 

(You must type in the full hardware path of 
the disk or logical box (LBA).)

Alternate boot disk Path to the alternate boot disk (optional)

(You must type in the full hardware path of 
the disk or logical box (LBA)).

Local bus adapter Name of the local bus adapter

Advanced setting: Kernel Path Kernel path

Advanced setting: Kernel Boot Kernel boot options
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This APX will make multiple calls to the vparmodify command to modify the vPar as needed. 
So while the vparmodify command has restrictions on the number of things that can be 
modified per command invocation, this APX does not.

Starting a vPar

To start a vPar, right-click on the vPar and select Start vPar. (Starting a vPar invokes the 
vparboot command, which always attempts to boot an OS from the primary boot disk 
regardless of the autoboot settings.)

Shutting Down a vPar

To gracefully shut down a vPar, right-click the vPar and select Shutdown vPar. This runs the 
HP-UX shutdown(1M) command on the vPar. This operation is only available when the vPar 
is an SA managed server and the status is Up.

Halting a vPar

To forcefully halt a vPar, right-click the vPar and select Halt vPar. This runs the HP-UX 
vparreset -f -h command to halt the vPar. This operation is only available when the vPar 
status is Up.

Deleting a vPar

A vPar that is not in Up status can be deleted. To delete a vPar, right-click on the vPar and 
select Delete vPar. This option is also available on the right-click menu of a vPar.

Managing HPVM Hypervisors

This section describes how to create, add, delete, and modify HPVM hypervisors and HPVMs 
using the HP-UX Virtualization Manager.

To manage HPVMs using the web-extension, the HPVM host must be a managed server in 
Server Automation. For instructions on how to convert HPVMs into managed servers, see the 
SA User Guide: Server Automation.

Creating an HPVM

To create an HPVM:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM hypervisor.

3 Choose Create VM to display the Create Virtual Machine window.
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4 Enter the following information for the new HPVM (You can create a new HPVM by just 
entering a name and accepting the defaults.):

Table 26 Create VM

Tab and Section
Field or 
Button Choice

Description and Default 
Setting

General

General Name HPVM name

(Can include up to 256 
upper or lower case 
alphanumeric characters; 
dash (—); underscore (_), 
and period (.))

Note: Cannot start with a 
dash

(Required)

Default: 
NewVirtualMachine.

Description HPVM description.

(Can include up to 256 
upper or lower case 
alphanumeric characters; 
dash (—); underscore (_), 
and period (.))
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Operating 
System will 
be HP-UX

Whether the HP-UX 
operating system be 
installed on this VM

Note: Installing the HP-UX 
operating system is not part 
of creating an HPVM. 

Default: Not selected.

When the 
host machine 
powers up, 
the HPVM 
should 
start:

Automatically Starts when host powers up

Default: Automatically.

Manually Start HPVM manually

CPU

Desired CPUs Number of 
CPUs

1 - 256 Number of CPUs dedicated 
to the HPVM

Default: 1

Entitlement

(click  to 
display choices)

Specify 
Processing 
Power

%Utilization:

• Minimum

• Maximum

% of each CPU to be used for 
the HPVM

% Utilization maximum 
must be >= % utilization 
minimum

Defaults: Minimum: 10; 
Maximum: 100

CPU Cycles

• Minimum

• Maximum

Number of CPU cycles 
(Mega Hertzs or Giga 
Hertzs)

Minimum number cannot be 
> maximum number

Maximum number cannot > 
CPU cycles available on 
system 

Memory

Desired Memory Memory MegaBytes (MB) of memory 
allocated to HPVM

Default: 512

Table 26 Create VM (cont’d)

Tab and Section
Field or 
Button Choice

Description and Default 
Setting
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Dynamic Memory 
Control

(click  to 
display choices)

Use dynamic 
memory 
control

Required: Checked Dynamic 
Memory Control box

Default: Disabled.

Initial 
Target 
Memory Size

Initial memory that 
dynamic memory driver 
tries to access when guest 
starts

Required: Checked Dynamic 
Memory Control box

Minimum 
Memory Size

Minimum memory available 
to be dynamically allocated 
to guest

Required: Checked Dynamic 
Memory Control box

Maximum 
Memory Size

Maximum memory 
available to be dynamically 
allocated to guest 

Required: Checked Dynamic 
Memory Control box

Virtual Networks List of vSwitches associated 
with HPVM

Defined Virtual 
Network - Add 
Virtual Switch

(click Add Virtual 
Switch to display 
choices)

vSwitch information for 
existing vSwitches

Network 
Adapter Type

LAN

AVIO-LAN

LAN or AVIO-LAN to 
associate with the vSwitch

Default: LAN

Network 
Interface 
Card

Any available

PCI Bus (0 - 7)

PCI Device (0-7)

Type of interface card to 
associate with the vSwitch

Default: Any available PCI 
bus or device (recommended 
choice)

Table 26 Create VM (cont’d)

Tab and Section
Field or 
Button Choice

Description and Default 
Setting
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Select a 
vSwitch

vSwitches available to 
associate with the HPVM

Note: Select the switch and 
click Done to add the switch 
to the list.

vSwitch Display Columns

(these criteria are for display purposes only)

Name vSwitch name

Status vSwitch status (Up or 
Down)

Type Shared or 
Exclusive

vSwitch type (shared with 
another HPVM or exclusive)

Number of 
HPVMs using 
vSwitch

Number of HPVMs that 
share the vSwitch

Network 
Adapter Type

LAN

AVIO-LAN

LAN 

AVIO-LAN

PCI Bus Peripheral Component 
Interconnect Bus (PCI Bus) 
associated with the vSwitch

PCI Device Peripheral Component 
Interconnect Device (PCI 
Device) associated with the 
vSwitch

Virtual Storage

Virtual Storage

(click  to 
display choices)

Information about virtual 
storage associated with the 
HPVM

Add Virtual 
Storage

Storage Type Emulated Small 
Computer 
System Interface 
(SCSI)

AVIO Storage

Type of storage to associate 
with HPVM

Default: Emulated SCSI

Virtual 
Device

Disk

Dvd

Virtual device to associate 
with HPVM

Default: Disk

Table 26 Create VM (cont’d)

Tab and Section
Field or 
Button Choice

Description and Default 
Setting
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5 Click Submit to create the HPVM and add it to the list.

Modifying HPVMs

To modify HPVM information:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM.

3 Choose Modify VM.

4 Change HPVM settings (see Creating an HPVM for more information on the settings).

Note: Modify VM has a setting that is not available in the Creating HPVM function: 

Advance Settings > Forced Configuration.

Choosing this setting will force the system to make configuration changes and suppress 
all resource conflict checks and associated warning messages. 

Note: If you choose this setting, there will be no notification of potential resource 
problems for a virtual machine that is modified with this option.

5 Click Submit to save the modifications.

Starting an HPVM

To start an HPVM:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM.

3 Choose Start VM.

Backing 
Store

Disk

Logical Volume

File System

Type of backing store to 
associate with the HPVM

Default: Disk

Device 
Special File 
(DSF) 
Addressing 
(for disk 
backing 
only)

Agile

Legacy

Type of storage device file 
addressing

Default: Agile

Select a 
Device (for 
disk backing 
only)

Device File/
Logical Volume

Type of Device

Note: Select a device from 
the list and click Done to 
add the device to the list.

Table 26 Create VM (cont’d)

Tab and Section
Field or 
Button Choice

Description and Default 
Setting
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For information about operating system installation, go to the HP Integrity Virtual Machines 
Installation, Configuration, Administration Guide at: http://docs.hp.com/hpux/11iv3, then 
choose: HP Virtualization Software > HP Integrity Virtual Machines and Online VM 
Migration.

Halting an HPVM

To halt an HPVM:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM.

3 Choose Halt VM.

Note: Halting an HPVM temporarily stops it from performing its functions and allows the 
manager to reallocate resources assigned to it.

Shutting Down an HPVM

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM.

3 Choose Shutdown HPVM.

Choosing shutdown means that the HPVM shuts down within 30 seconds. If the time-out 
period expires before the shutdown occurs, a hard stop occurs.

Note: Shutting down an HPVM takes the machine offline and allows the manager to 
reallocate resources assigned to it.

Removing or Deleting an HPVM

To remove or delete an HPVM from HP-UX Virtualization Manager control:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVMs to delete.

3 Choose Delete VM, and click OK when asked to confirm the deletion.

4 The HPVM is removed from the list of managed servers.
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Managing vSwitches

This section describes how to create, modify, and delete a vSwitch.

Note: HP-UX Virtualization Manager manages vSwitches. To view HPVM/vSwitch settings, 
go to the HP Integrity Virtual Machines Installation, Configuration, Administration Guide at: 
http://docs.hp.com/hpux/11iv3, then choose: HP Virtualization Software > HP Integrity 
Virtual Machines and Online VM Migration. For instructions on how to configure LANs and 
VLANs, see LAN/VLAN documentation. 

Creating a vSwitch

To create a vSwitch:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click an HPVM hypervisor.

3 Choose Create vSwitch to display the Create vSwitch window.
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4 Enter the following information for the new vSwitch:

Modifying a vSwitch

To modify vSwitch information:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to access the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, right-click a vSwitch.

3 Choose Modify vSwitch.

4 Change vSwitch settings.

The fields that cannot be modified will not be enabled.

Starting a vSwitch

To start a vSwitch:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to access the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, right-click a vSwitch.

3 Choose Start vSwitch.

Table 27 Create vSwitch

Field/Button Description

Name Choose a name for the vSwitch that does not exceed 
eight (8) characters.

Default: Switch1

Type Sharable (shared with other HPVMs) or dedicated 
(associated only with this HPVM)

Default: Shareable

Create a local virtual 
switch, OR

Select a LAN interface to 
connect to (must select the 
LAN from the list)

Local switch that is not connected to another device.

LAN to connect to (Default)

Start the virtual switch 
after creating

Starts the vSwitch immediately after it is created.

Default: Not selected
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Stopping a vSwitch

To stop/halt a vSwitch:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to access the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, right-click a vSwitch.

3 Choose Stop vSwitch.

Note: Halting or stopping a vSwitch temporarily stops it from performing its functions and 
allows the manager to reallocate resources assigned to it.

Deleting a vSwitch

To delete a vSwitch from HP-UX Virtualization Manager control:

1 Follow the instructions in Launching the HP-UX Virtualization Manager to access the 
HP-UX Virtual Servers window.

2 In the HP-UX Virtual Servers window, right-click a vSwitch to delete.

3 Choose Delete vSwitch, and click OK when asked to confirm the deletion.

Configuring vLAN Connections

To configure vLAN connections:

1 Follow the instructions in Launching the HP-UX Virtualization Manager.

2 In the HP-UX Virtual Servers window, right-click a vSwitch.

3 Choose Configure VLAN.

4 For each HPVM, choose the corresponding VLAN ID. 

Troubleshooting

This section explains how to troubleshoot HP-UX virtualization.

The HP Support web site provides contact information and details about the products, 
services, and support that HP Software offers. 

For more information or to get help with your issue, contact HP Support: 

http://www.hp.com/managementsoftware/support

Troubleshooting Issues

Problem: The HP-UX Virtualization Manager extension is not displayed in the SA Library.

• Make sure your user has permission to view and execute the web extension. For details, 
see Folder Permissions Required on page 69.
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Problem: When adding virtual servers, an HP-UX server does not appear in the search 
results. Or, when searching all servers, the server displays but when searching for specific IP 
addresses, it does not.

• Set the Display drop-down list to All Servers and search again.

• Ensure the server is a managed server. For more information, see the SA User Guide: 
Server Automation.

• Perform a hardware registration. On the managed server, run the following SA command:

/opt/opsware/agent/pylibs/cog/bs_hardware

Problem: When adding virtual servers, a particular server only shows in the results when 
display is set to All Servers.

• Ensure either Virtual Partition or HP VM software is installed on the server

• Perform a software registration. On the managed server, run the following SA command:

/opt/opsware/agent/pylibs/cog/bs_software

Problem: The Summary view for a server does not display all information about the server.

• If the server is not managed by SA, some information may not be displayed. Bring the 
server under SA management. For instructions, see the SA User Guide: Server 
Automation.

• If the server is a managed server, perform a hardware registration. On the managed 
server, run the following SA command:

/opt/opsware/agent/pylibs/cog/bs_hardware

Checking Log Files

Log files are stored in the user’s /tmp directory in the Global File System (OGFS). To access 
them, log in to the OGSH and change directory to /tmp.

The name of the log file for HP-UX virtualization is hpuxvirtlog. This is a rotating log file, so 
over time you will see hpuxvirtlog.1 and hpuxvirtlog.2 up to a maximum of 3 log files. The 
current log file is always hpuxvirtlog. The file rotates when the size reaches 5Mb.

The log file shows informative messages, warnings and errors. The informative messages 
show the vPars and HP VM commands that are executed on the managed servers.

Nearly all errors and warnings are displayed in the HP-UX Virtualization manager, so 
checking the log files is usually not necessary.

Example Log Messages

Here are example log messages:

2011-05-31 10:53:59 INFO HPUX-V12N(127): Requested operation: modify_virtual_machine

2011-05-31 10:54:00 INFO HPUX-V12N.vpar(416): dhcp-184-241: scanning

2011-05-31 10:54:03 INFO HPUX-V12N.vpar(462): /usr/sbin/vparmodify -p vpar2 -m 
cell:1:cpu::1

Returned: 0
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2011-05-31 10:54:03 INFO HPUX-V12N.vpar(462): /usr/sbin/vparmodify -p vpar2 -B search

Returned: 0

The messages include the date, time, log level (INFO), module (HPUX-V12N and 
HPUX-V12N.vpar), and the message text. The lines above show a modify operation performed 
on a vPar (vpar2). The modify commands were executed on server dhcp-184-241 and both 
commands returned 0, meaning they were successful.
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9 Managing Oracle Solaris Zones
This section describes how to manage Oracle Solaris Zones with the SA Client. 

To perform any of these tasks, the zone must be reachable by SA.

OS Provisioning and Agent Installation for Oracle Solaris Zones

Figure 22 shows the process for creating a non-global zone and bringing it under Agent 
management by SA. You can create a zone using either the SA Client or the Solaris 
commands. When you use the SA Client to create a zone, SA also installs an Agent on the 
zone, which allows you to manage the zone using SA.

Figure 22 OS Provisioning and Agent Installation on an Oracle Solaris Zone

Create Zone 
using SA Client

Managed Hypervisor
(Global Zone)

Create Zone 
using Solaris

Install Agent 
using SA

Managed Zone
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To find out more about the tasks shown in Figure 22, see the documentation referenced in 
Table 28.

Creating a Zone

The SA Client enables you to create a fully operable, non-global zone on a Solaris global zone 
(hypervisor). 

Before a non-global zone can be created with the SA Client for the first time, the global zone’s 
hardware must be registered with SA. This hardware registration only needs to occur once. 
Creating a non-global zone also installs an Agent on the zone, bringing the zone under Agent 
management by SA. After Agent installation, the non-global zone appears in the All 
Managed Servers and the Virtual Servers lists in the SA Client.

To create a non-global zone, perform the following steps:

1 In the SA Client, from the navigation pane, select the Devices tab.

2 Expand Servers and select Oracle Solaris Zones.

3 In the content pane, right-click the global zone that will host the new zone, and select 
Oracle Solaris Zones ➤  Create Zone.

4 In the Zone Definition Method step of the Create Virtual Zone window, select one of the 
following methods:

• Manual (Fill out data form): Using this method, you must manually enter the zone 
configuration parameters in the fields provided on the Zone Definition dialog.

• Zone Creation Command Script: Using this method, you provide a command 
script that contains the zone creation and configuration commands. This command 
script has the same syntax as the command_file specified by the following Solaris 
command:

zonecfg -z zone_name -f command_file

SA does not validate the contents of the zone creation command script, so ensure that your 
script works. For the syntax of the commands allowed in the script, see the Solaris 10 
documentation on zonecfg.

5 Click Next to proceed to the Zone Definition step. 

6 If you are using a Zone Creation Command script, skip to step 7 below. If you chose the 
manual method in step 4 above, complete the following fields:

• Server: Enter the SA server name for the new virtual server. (The global zone 
(hypervisor) that will host the new non-global zone is displayed below this field.)

Table 28 Documentation for Zone OS Provisioning and Agent Installation

Task in Figure 22 Where to get more information

Create a Zone using the SA Client Creating a Zone on page 98

Create a Zone using Solaris Solaris 10 documentation

Install an Agent using the SA Client Installing an Agent on an Existing Unmanaged 
Non-Global Zone on page 100
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• Zone Name: Enter an appropriate name for the new non-global zone. 

• Locale: Enter the language code for the non-global zone. 

• Terminal Type: Specify the terminal client that the SA Client uses for Remote 
Terminal sessions on the non-global zone. 

• Auto Reboot: Specifies whether to automatically reboot the non-global zone if the 
physical server running the hosting Global zone is rebooted.

• Time Zone: Specify a time zone for the non-global zone.

• Root Password: Enter the root password for the non-global zone. 

• Confirm Password: Enter the root password again for verification. 

• CPU Shares Reservation: Enter an integer that allocates the shares of the CPU 
resource. 

For the CPU Shares Reservation to take effect, the Fair Share Scheduler (FSS) must be 
enabled on the Solaris 10 hypervisor server on which you are creating the new zone. By 
default, the FSS is not enabled.

• IP Address: Click Add to enter the IP address and the name of the virtual network 
interface. A zone that requires network connectivity must have one or more dedicated 
IP addresses. These addresses are associated with the physical network interface of 
the global zone. 

• Device: (Optional) Click Add to enter a path name to a device, for example, /dev/
pts*, on the global zone hypervisor. This action gives the new zone access to a device 
on the global zone. 

• Inherited Package Directory: (Optional) Click Add Sparse Root Directory to 
enter a default package directory inherited by the new zone from the global zone. Or, 
click Add to enter a path name to the package directory you want the zone to inherit. 
These package directories are read-only.

• Mount Directory: (Optional) Click Add to mount a file system type and path for the 
zone. This action grants the zone access to a physical disk or file system of the 
non-global zone. A ufs file system creates a file system mount within the zone; the 
lofs type is a loopback file system mount to the global zone.

7 If you are using a Zone Creation Command Script, you will see the Zone Configuration 
Commands section. Here you can manually enter the contents of the zone creation 
command script, cut-and-paste from another file, or select Import File to import the 
script directly from another file, then select Next.

8 Scheduling: Select when you want the create zone job to run, then select Next.

9 Notifications: Enter email addresses to receive notifications when the job finishes. 
Select the type of notifications you want. Optionally enter a ticket identifier to be 
associated with the job, then select Next.

10 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it creates the zone and displays the results.
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Installing an Agent on an Existing Unmanaged Non-Global Zone

To bring a zone under agent management by SA, you must first install an SA Server Agent. 
Before installing an Agent, verify that the following requirements are met:

• The non-global zone is running.

• All services on the non-global zone are up and running. If they are not, the zone may not 
have the necessary sysconfig information that is provided when the non-global zone is 
booted for the first time. See the Sun Solaris 10 documentation on zone configuration for 
more information.

You can install an Agent on an unmanaged Oracle Solaris Zone in two ways:

• Using SA as described in “Installing and Managing User Agents” in the SA User Guide: 
Server Automation. 

• in the SA User Guide: Server Automation.

• Using the SA zone management interface.

To install an Agent on an unmanaged non-global zone through the SA zone management 
interface, perform the following steps:

1 In the navigation pane, select Devices.

2 Expand Servers, and then select Oracle Solaris Zones. 

3 In the content pane, expand the Global zone that hosts the unmanaged non-global zone 
you want to modify.

4 Right-click the non-global zone and select Oracle Solaris Zones ➤  Install Agent.

Modifying a Non-Global Zone

You can modify a subset of the zone parameters that were defined when you created the 
non-global zone. For example, if an HTTP server running on a zone is sluggish because of 
increased usage, you can increase the CPU Share Reservation parameter for the zone. After 
you modify a zone with the SA Client, the zone is automatically restarted.

To modify the parameters of a non-global zone, perform the following steps:

1 In the SA Client, from the navigation pane, select the Devices tab.

2 Expand Servers and select Oracle Solaris Zones. 

3 In the content pane, expand the global zone that hosts the zone you want to modify.

4 Right-click the non-global zone and select Oracle Solaris Zones ➤  Modify Zone.

The Modify Virtual Zone window appears. In the Zone Definition step of the Modify 
Virtual window, edit the parameters you want to change, then select Next.

5 Scheduling: Select when you want the modify zone job to run, then select Next.

6 Notifications: Enter email addresses to receive notifications when the job finishes. 
Select the type of notifications you want. Optionally enter a ticket identifier to be 
associated with the job, then select Next.
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7 Job Status: Select the Start Job or Schedule Job button. This runs the job or schedules it 
to be run in the future and displays the Job ID number in the window banner. You can use 
the Job ID number to look up the job under the Jobs and Sessions tab.

When the job runs, it modifies and restarts the zone and displays the results.

Starting or Stopping a Non-Global Zone

To start or stop a non-global zone, perform the following steps:

1 In the navigation pane, select the Devices tab.

2 Expand Servers and select Oracle Solaris Zones.

3 In the content pane, expand the global zone that hosts the non-global zone. 

4 Right-click the zone and select Oracle Solaris Zones ➤ Start Zone or Stop Zone.

Or

5 In the Oracle Solaris Zones list, open the hypervisor. In the Virtualization view, select 
the zone and click either Start or Stop.

If a non-global zone is not running, the state displayed is Installed.

Deleting a Non-Global Zone

This action deletes the non-global zone permanently and removes it from the SA.

1 In the SA Client, from the navigation pane, select the Devices tab.

2 Expand Servers and select Oracle Solaris Zones.

3 In the content pane, expand the global zone that hosts the zone you want to delete.

4 Right-click the non-global zone and select Oracle Solaris Zones ➤  Remove Zone.

Reloading Oracle Solaris Zone Information

Because Oracle Solaris Zones can be created and managed outside of SA, SA automatically 
reloads the virtual server information every 24 hours.

To reload Oracle Solaris Zone information manually, perform the following steps:

1 In the SA Client navigation pane, select the Devices tab, then select Servers > Oracle 
Oracle Solaris Zones. This action displays all your Oracle Solaris Zones being managed 
by SA.

2 Locate the hypervisor whose information you want to reload. Right-click or select the 
Actions menu and select Oracle Solaris Zones > Reload Data.
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A Virtualization Concepts and Terms
This section defines terms in this guide. For more information, also refer your virtualization 
vendor’s documentation.

Agent – The SA agent is software that runs on a server and enables SA to manage the server. 
The SA agent must be installed on physical and virtual servers for full management 
capabilities on servers.

Clone – (n.) A virtual machine created by copying another virtual machine. The clone is 
identical to the original machine in that it has the same operating system, software, patches 
as well as CPU, memory and network resources. (vb.) The action of making a copy of a virtual 
machine.

Cluster – A group of hosts that share resources and can be managed as a unit. You can create 
virtual machines that run on and share the resources of the cluster. When you add a host to a 
cluster, that host’s resources become part of the cluster’s resources. The cluster provides a way 
to manage the resources of the hosts within it. Clusters also enable high availability and load 
balancing.

Datacenter – The top level container for a set of VMware virtualization resources. A 
datacenter contains hosts, clusters, resource pools, datastores, and virtual machines. These 
items can also be organized in folders.

Datastore – A VMware container of storage elements used to allocate storage to virtual 
machines.

Folder – A location and a container in the virtualization inventory where virtualization 
objects are stored and accessed. Folders also provide access control based on permissions.

The SA Library also uses folders to organize and control access to other items such as patches, 
patch policies, software packages, and so forth.

Guest Customization – The process of modifying a new virtual machine to make it unique. 
This may include setting the host name, domain name, time zone, and static IP address. 
Guest customization is typically one step in deploying a VM from a VM template or in cloning 
a VM.

Guest Operating System – The configuration setting indicating the operating system 
running on the virtual machine. Note that this setting may be different from the actual 
operating system running on the VM.

Guest Tools – The virtualization vendor’s software that runs on a virtual machine and 
improves integration and performance of the VM. Guest tools perform operations such as 
synchronizing system clocks and providing a heart beat back to the Virtualization Service. 
Also called VMware Tools in VMware and Virtual Machine Additions in SCVMM.

• Best Practice - Always install the guest tools on all your VMs for best integration.

Host – A server that uses virtualization software to run VMs. A host provides CPU and 
memory resources, and access to storage and networks for VMs.

Host Groups – In SCVMM, containers you can create to group a set of virtual machine hosts 
for easier management. Host groups are hierarchical and can contain other host groups.
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Hypervisor – A software program that provides the ability to run VMs and typically runs on 
physical server. May also be called a host.

Management Path – The method by which SA manages a server. Three management paths 
are available: agent managed, VS managed and iLO managed. Servers can be managed by 
more than one management path.

• Agent Managed - Servers managed by the SA agent. The SA agent provides the most 
management capabilities.

• VS Managed - Servers managed by a Virtualization Service such as VMware vCenter 
Server or Microsoft SCVMM.

• iLO Managed - Servers managed by HP Integrated Lights Out. For more information, see 
www.hp.com/go/iLO.

NIC – network interface card.

PXE - The Preboot Execution Environment, or PXE, is an environment in which to boot 
computers using a network interface independently of data storage devices or installed 
operating systems.

Resource Pool – In VMware, a way to divide the resources of a host or a cluster into smaller 
pools. A resource pool contains a set of CPU and memory resources that all the VMs running 
in the resource pool share. Resource pools provide the ability to balance workloads across the 
resource pool.

SCVMM – System Center Virtual Machine Manager, Microsoft’s management tool for 
managing hypervisors and virtual machines.

vCenter Server – VMware’s Virtualization Service for managing ESX and ESXi hypervisors, 
and virtual machines.

Virtualization Containers – Any container of virtualization resources including clusters, 
datacenters, folders, host groups, hypervisors, resource pools, and virtualization services.

Virtualization Service – A platform for centrally managing virtual resources such as 
hypervisors and virtual machines. Examples are VMware vCenter Server and Microsoft 
System Center Virtual Machine Manager (SCVMM).

Virtual Machine (VM) – A software version of a computer, consisting of an operating 
system, storage, networking and applications, just like a physical computer.

VM Template – A specification for a virtual machine. You can create a virtual machine from 
a VM template and you can create a VM templates from a virtual machine. A VM template 
typically includes an OS Build Plan for installing an operating system, patch policies that 
specify patches to be installed, software policies that specify software to be installed, 
application configurations that specify how the software should be configured, audit policies 
that specify rules that define compliance, and the SA agent for managing the virtual machine. 
VM templates allow you to control what type of virtual machines get created and they allow 
you to keep your virtual machines in compliance.
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B Upgrading Virtualization from HP SA 9.x
This section describes how to upgrade your virtualization inventory from HP SA 9.x to HP SA 
10.0. This process is only needed if you are managing Virtualization Services (VSs) such as 
VMware vCenter Server, or hypervisors such as ESX, ESXi, or Hyper-V with any HP SA 9.x 
versions.

You must perform these upgrade tasks to manage your virtualization inventory on HP SA 
10.x.

Summary of the Migration Process

This lists the steps to take when migrating your virtualization inventory. See the following 
sections for details.

1 Run the migration script with the --list option to get a summary of your virtualization 
environment. See 1) Prepare to Migrate - Use the --list Option on page 105.

2 Examine the output of the --list option. See 2) Examine the Output from the --list Option 
on page 106.

3 If you have any VSs on servers not managed by an SA agent, manually install the SA 
agent on those servers. For details, see 3) Migrate Virtualization Services Not Managed by 
an Agent on page 107.

4 If you have any individual SA managed hypervisors, manually add those hypervisors to a 
VS, then add those VSs to SA. For details, see 4) Migrate Individually Managed 
Hypervisors on page 107.

5 Run the migration script with the --migrate option. See 5) Migrate with the --migrate 
Option on page 108.

6 Optionally run the migration script with the --clean_all option. See 6) Clean Up with 
the --clean_all Option on page 108.

7 Examine and verify your virtualization environment in the SA Client.

1) Prepare to Migrate - Use the --list Option

After you upgrade your SA cores to SA 10.x, prepare for the migration by running the migrate 
script with the --list option. This will display the current VS configuration and help you 
determine what you need to do. For example:

/opt/opsware/bin/python2 v12n_migrate.py --list

For details on the migration script, see Migration Script Reference on page 108.

The --list option displays the following:
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• All the VSs you have running.

• For each VS, whether it is running on an agent-managed server or not.

• All the hypervisors running under the VS.

• All your individually managed hypervisors: ESX, ESXi and Hyper-V.

2) Examine the Output from the --list Option

This section describes the output of the --list option and the steps to take based on that 
output. The --list option gives the following output: 

• All Managed vCenter Servers lists the VSs being managed by SA and whether or not 
manual migration is required for them. If you have any VSs that require manual 
migration, migrate them as described in 3) Migrate Virtualization Services Not Managed 
by an Agent on page 107.

• Individually Managed Hypervisors lists the hypervisors being managed by SA. If you 
have any individually managed hypervisors, you must migrate them as described in 4) 
Migrate Individually Managed Hypervisors on page 107.

Sample Output 1 - Manual Migration Required

The following is sample output with yellow highlighting added to show one vCenter server 
that requires manual migration and three individually managed hypervisors that require 
manual migration:

Figure 23 Sample Output of the Migration Script with the --list Option
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Sample Output 2 - No Manual Migration Required

The following is sample output with yellow highlighting added to show one vCenter server 
that does not require manual migration because it is running on an agent-managed server, 
and no individually managed hypervisors:

Figure 24 Sample Output of the Migration Script with the --list Option

3) Migrate Virtualization Services Not Managed by an Agent

If you have Virtualization Services managed by SA but not agent-managed, you must install 
an SA agent on those servers. For instructions on installing the SA agent on servers, see 
Installing the SA Agent on page 121 in the SA User Guide: Server Automation.

If you have no VSs managed by SA or all your VSs are on agent-managed servers, skip this 
step.

4) Migrate Individually Managed Hypervisors

If you have hypervisors managed by SA, such as VMware ESX, ESXi or Microsoft Hyper-V, 
you must manage them under a Virtualization Service.

If you have no hypervisors individually managed by SA, skip this step.

1 For the ESX and ESXi servers, bring them under management of a VMware vCenter 
Server. For instructions, see the VMware documentation.

2 For the Hyper-V servers, bring them under management of a Microsoft System Center 
Virtual Machine Manager (SCVMM). For instructions, see the Microsoft documentation.

3 Use the SA Client to add the VSs to SA management. For instructions, see Add 
Virtualization Service on page 38.
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5) Migrate with the --migrate Option

To migrate all your virtualization data, run the migration script with the --migrate option. 
For example:

/opt/opsware/bin/python2 v12n_migrate.py --migrate --user <SA username> 
--password <password>

For details on the migration script, see Migration Script Reference on page 108.

This migrates your existing virtualization inventory to the HP SA 10.0 format.

6) Clean Up with the --clean_all Option

After performing the migration, old data remains in the SA database. Leaving this data in the 
SA database will not cause any problems, however you can safely remove this data by using 
the --clean_all option. 

Use the --clean_all option only after using the --migrate option. Once you use the 
--clean_all option, no further migration can be performed.

The following is an example command with the --clean_all option:

/opt/opsware/bin/python2 v12n_migrate.py --clean_all --user <SA username> 
--password <password>

This removes all the old virtualization data from the SA database.

For details on the migration script and the --clean_all option, see Migration Script 
Reference on page 108.

Migration Script Reference

This section describes the virtualization migration script and all its options.

Location of the Migration Script

The migration script is on your SA product distribution located at 
/<distro>/opsware_installer/tools/v12n_migrate.py .

The python interpreter is on your SA core server at /opt/opsware/bin/python2.

For more information, see the SA Simple/Advanced Installation Guide.

Where to Run the Migration Script

Run the migration script on the primary SA core server where the infrastructure component 
is running. For more information on SA cores and components, see the SA Simple/Advanced 
Installation Guide.
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Set Up Your Environment

Before you run the migration script, you must set up your environment. Set the following 
environment variables on the SA core server where you will run the migration script:

export PYTHONPATH=/opt/opsware/spin:/opt/opsware/pylibs2
export LD_LIBRARY_PATH=/opt/opsware/lib/

Location of the Log Files

When you run the migration script, it writes log information to the following files:

• /var/opt/opsware/log/v12n_migration.log provides more information whenever you 
run the migration script.

• /var/log/opsware/twist/v12n_migration_delete.log provides more information 
whenever you run the migration script with any of the --clean options.

Syntax of the Migration Script

/opt/opsware/bin/python2 v12n_migrate.py <options>

Options

Use the following options with the migration script.

Table 29 Migration Script Option

Option Description

--list
-l

List all the VMware vCenter Servers with their managed 
hypervisors and all the individually managed hypervisors.

--migrate
-m

Migrate all agent-managed VMware vCenter Servers to SA 10.0. You 
must use the --username and --password options with this option.

--username=<name>
-u=<name>

An SA user name. This option is required by the --migrate option 
and all of the --clean options.

--password=<pw>
-p=<pw>

The password for the user name specified in the --username option.

--clean_vms
-cv

Clean up all the old VMware vCenter Server data and related 
inventory data by permanently deleting the records from the SA 
database. 

Use this option only after using the --migrate option because the 
old data is permanently removed. Once you use this option, no 
further migration can be performed.

This option requires the --username and --password options.
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--clean_hv
-ch

Clean up all the old individually managed ESX or ESXi hypervisor 
data by permanently deleting the records from the SA database. 

Use this option only after using the --migrate option because the 
old data is permanently removed. Once you use this option, no 
further migration can be performed.

This option requires the --username and --password options.

--clean_all
-ca

Clean up all the old virtualization data. This option is equivalent to 
--clean_vms and --clean_hv options. 

Use this option only after using the --migrate option because the 
old data is permanently removed. Once you use this option, no 
further migration can be performed.

This option requires the --username and --password options.

--help
-h

Display help for the migration script.

Table 29 Migration Script Option

Option Description
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